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About this document 

The document is a deliverable of the InSIDE project, prepared by the InSIDE UOA project team. Vital part 
of the document is the numerous and extensive Appendices at the end of the document. 

The present deliverable report covers the following project tasks and activities: 

TASK 3.3 Software adaptations on the selected LMS with the aim of accessibility, usability and educational 
efficiency improvement for both students with ViHeMo impairments and students without impairments 

Activities:  

• A.3.3.1 Implementation of the adaptations related to the accessibility issues 
• A.3.3.2 Implementation of the adaptations related to the usability issues 
• A.3.3.3 Configuration of the tools/services that will improve the educational efficiency of the LMS 
• A.3.3.4 Delivery of the adapted LMS 
 

 

  



InSIDE project Page 
12 

WP3: Development 

2018-3218 /001-001 Deliverable DEV3.3 Adaptations and Delivery of LMS platform  

 

1. Introduction 

Based on the previous results of the InSIDE project (results from PR1.1 State of the Art concerning 
DE programmes, PR1.3 Recording of the LMSs, DEV3.1 Assessment of the most widespread LMSs, 
and DEV3.2 Detailed assessment of an open-source LMS), the most widespread Learning 
Management Systems (LMSs) were critically examined in reference to their accessibility and 
usability aspects, targeting to propose educational efficiency improvements to increase their usage 
by individuals with disabilities and students without impairments. Hence, LMS developers or 
providers could apply the proposed improvements contained in these documents (Koustriava, et al., 
2020). 
The answer to what LMS best suits an educational project is not trivial. Three factors contribute to 
the complexity of this question. Firstly, the ecosystem of software implementations for Distance 
Education (DE) delivery changes quickly pushed by the constant evolution of DE and innovations in 
educational institutions. Secondly, the features of LMSs are quite diverse and difficult to match when 
comparing. This fact may be explained due to the different teaching methodologies used to ground 
implementation and disparity in targeted learner profiles. Thirdly, each educational project has its 
own priorities and requirements. The establishment of appropriate criteria to weight the desired 
features for the selection of the LMS is of paramount importance and one of the key points for the 
success of a distance educational project (Salinas Lopez, 2020). 
Moodle is the world's most popular Learning Management System (LMS) (moodle, 2020a). It is also, 
a learning platform designed to provide educators, administrators, and learners with a single robust, 
secure, and integrated system to create personalized learning environments (moodle, 2020b). 
Moodle is designed to provide equal functionality and information to all people. This means that there 
should be no barriers for people regardless of disabilities, assistive technologies that are used, 
different screen sizes and different input devices (e.g.: mouse, keyboard, and touchscreen) (moodle, 
2019). 
All non-text content in Moodle that is presented to the user can have a text alternative that serves 
the equivalent purpose. The Moodle interface is presented as an HTML application developed to 
comply with the WCAG AA standard for accessibility. All parts of the Moodle interface are either 
native HTML controls with correct accessible text descriptions, or advanced HTML controls that have 
been developed to comply with the WCAG 2.0 AA as well as the Section 508 standards and tested 
with a range of screen reader software (eThink, 2018). 
Furthermore, the built-in “Atto text editor” in Moodle provides many of the tools you need to design 
your course content with accessibility in mind. Some helpful functionality and features of the “Atto 
text editor” include the ability to edit section headings, provide descriptions for activities and 
discussion forums, and compose an answer to a quiz question. The “Atto text editor” also has an 
“Accessibility Checker” tool that will scan the content of the text editor and alert you to a range of 
accessibility issues that may be found within the text (eThink, 2018). 
Even though the “Atto text editor” can produce accessible content on the Moodle platform and checks 
the content it creates, the InSIDE UOA project team noticed that no such check is performed on the 
files being uploaded on the platform. To deal with this issue, the scientific team provides the user 
with instructions for creating accessible files that instruct him/her to modify his/her files appropriately 
before posting them on the platform. Moodle platform is also altered by the InSIDE UOA project team 
so that an warning message is displayed whenever the user attempts to upload a file to a course to 
remind the user to check it for accessibility. A fresh Moodle installation on the UOA’s servers was 
used to perform these alterations and a special universal menu has been added to give access to 
resources and guidelines for preparing accessible documents to be uploaded on the platform. 
This altered and accessibility-enhanced Moodle installation, but also its usability and e will serve the 
needs of following InSIDE project’s tasks activities, such as trainings. 
The present deliverable report covers the following project tasks and activities: 
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TASK 3.3 Software adaptations on the selected LMS with the aim of accessibility, usability and educational 
efficiency improvement for both students with ViHeMo impairments and students without impairments 

Activities:  

• A.3.3.1 Implementation of the adaptations related to the accessibility issues (Section 3. Moodle 
Accessibility, Section 5. Modification of Moodle to improve its accessibility)  

• A.3.3.2 Implementation of the adaptations related to the usability issues (Section 2. Accessible 
Documents) 

• A.3.3.3 Configuration of the tools/services that will improve the educational efficiency of the LMS 
(Section 4. Technical features of the InSIDE Moodle platform installation) 

• A.3.3.4 Delivery of the adapted LMS (Appendices 1 to 11) 
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2. Accessible Documents 

2.1. Creating Accessible Documents 

Following the principles of Universal Design for Learning (Kouroupetroglou et all, 2015, Riviou & 
Kouroupetroglou, 2014, Riviou, Kouroupetroglou & Oikonomidis, 2015), when creating content, there 
are a few basic steps that should be followed to assure your content is accessible, usable, and 
educational efficient for both students with ViHeMo impairments and students without impairment. 
For simplicity, with the use of the term accessibility in the next of this document we also include its 
usability and its educational efficiency for both students with ViHeMo impairments and students 
without impairments. 

The core steps needed for accessibility are the same regardless of whether your document is in 
HTML, Microsoft Word, Adobe PDF, or another document format (University of Washington, 2021): 

• Use easily readable fonts 
• Use appropriate color/contrast combinations 
• Use headings 
• Use lists 
• Use meaningful hyperlinks 
• Add alternate text to images 
• Identify document language 
• Use tables wisely 
• Understand how to export from one format to another. 

2.1.1. Use easily readable fonts 
Your choice of font family, style, weight, size, color, and line-height can all affect its legibility and 
readability on screen. Legibility is the ability of someone to discern what is written. Capta text is 
often barely legible, as an example. Avoid the use of Script text, for legibility reasons. Readability is 
how easy or difficult it is to read the content. Readability is affected by not only your style of writing, 
but your choice of and formatting of text on the page. 

When selecting a font family for screen viewed text, you will want to select families and weights that 
have a substantial stroke thickness and medium sized x-heights. The x-height is the height of the 
lower case letter x within the font family. All the lower case letters within the font typically have the 
same height as the x height. 

Sans-serif fonts, such as Arial, Verdana, Helvetica, Tahoma, Trebuchet MS, or Myriad Web Pro are 
good choices for body text. Though you want to pick fonts with substantial stroke thickness, it may 
be a good idea to avoid the use of a font that is designed primarily as bold, such as Arial Rounded 
MT Bold, because you are left with few options for formatting for importance. If you apply a Strong 
Style (bolding), to an already bold font, it makes the font so thick, it becomes difficult to read on 
screen (PRESSBOOKS, 2021). 

2.1.2. Use appropriate color/contrast combinations 
Some users have difficulty perceiving text if there is too little contrast between foreground and 
background. The W3C Web Content Accessibility Guidelines 2.0 define specific contrast ratios that 
must be met in order to comply at particular levels. In order to meet the guidelines at Level AA, text 
or images of text must have a contrast ratio of at least 4.5:1 (or 3:1 for large text). In order to meet 
the guidelines at the stricter Level AAA, the contrast ratio must be at least 7:1 (or 4.5:1 for large text) 
(University of Washington, 2021) 
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2.1.3. Use Headings 
Headings and subheadings should be identified as such using the built-in heading features of the 
authoring tool. Headings should form an outline of the page content (Heading 1 for the main heading, 
Heading 2 for the first level of sub-headings, Heading 3 for the next level of sub-headings, etc.). This 
enables screen reader users to understand how the page is organized, and to quickly navigate to 
content of interest. Most screen readers have features that enable users to jump quickly between 
headings with a single keystroke. 
Virtually every document authoring format includes support for headings and subheadings 
(University of Washington, 2021). 

2.1.4. Use Lists 
Any content that is organized as a list should be created using the list controls that are provided in 
document authoring software. Most authoring tools provide one or more controls for adding 
unordered lists (with bullets) and ordered lists (with numbers). When lists are explicitly created as 
lists, this helps screen readers to understand how the content is organized. When screen reader 
users enter a list, their screen reader informs them that they are on a list and may also inform them 
of how many items are in the list, which can be very helpful information when deciding whether to 
continue reading (University of Washington, 2021). 

2.1.5. Use Meaningful Hyperlinks 
Links presented in an electronic document should convey clear and accurate information about the 
destination. Most authoring tools allow the creator to assign a hyperlink to text (University of 
Washington, 2021). 

2.1.6. Add Alternate Text for Images 
Users who do not have the ability to see images depend on content authors to supplement their 
images with alternate text, which is often abbreviated “alt text”. The purpose of alt text is to 
communicate the content of an image to people with blindness. The alt text should be succinct, just 
enough text to communicate the idea without burdening the user with unnecessary detail. When 
screen readers encounter an image with alt text, they typically announce the image then read the alt 
text. 
Most authoring tools provide a means of adding alternate text to images, usually in a dialog that 
appears when an image is added, or later within an image properties dialog. 
If images are purely decorative and contain no informative content, they do not require a description. 
However, they may still require specific markup, so screen readers know to skip them. 
Also, images that require a lengthier description, such as charts and graphs, may require additional 
steps beyond adding alt text (University of Washington, 2021). 

2.1.7. Identify document language  
Leading screen reader software is multilingual, and can read content in English, Spanish, French, 
and a wide variety of other languages. To ensure that screen readers will read a document using the 
appropriate language profile, the language of the document must be identified. 
The language of any content written in a language other than the document’s default language 
should also be identified. With this information, supporting screen readers will switch between 
language profiles as needed on the fly. 
Most document authoring tools provide a means of identifying the document language as well the 
language of specific parts (University of Washington, 2021). 
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2.1.8. Use Tables Wisely 
Tables in documents are useful for communicating relationships between data, especially when 
those relationships can be best expressed in a matrix of rows and columns. Tables should not be 
used to control layout. Authoring tools have other means of doing this, including organizing content 
into columns. 
If your data is best presented in a table, try to keep the table simple. It the table is complex, consider 
whether you could divide it into multiple smaller tables with a heading above each. 
A key to making data tables accessible to screen reader users is to clearly identify column and row 
headers. Also, if there are nested columns or rows with multiple headers for each cell, screen readers 
need to be explicitly informed as to which headers relate to which cells (University of Washington, 
2021). 

2.2. Checking the Accessibility of a PDF 

It is always best, if possible, to start with an accessible source document (e.g., in Microsoft Word) 
and export to an accessible PDF. This way, if the document is edited later, the document’s 
accessibility features will still be intact; and when the document is exported again to PDF, the 
accessibility features will again be passed to the PDF. 
However, if the original source document is not available, accessibility features can be added to the 
PDF using Adobe Acrobat Pro DC. 
Consult the following checklist to check a PDF for accessibility. To complete each of the items in this 
checklist, you will need Adobe Acrobat Pro DC. The checklist specifically applies to Acrobat Pro DC 
(University of Washington, 2021). 
WebAIM’s tutorial on PDF Accessibility makes for an excellent accompaniment to the current 
checklist. 
When checking the accessibility of a PDF follow the steps below (University of Washington, 2021): 
Step 1. Does document have text? 
How to test: Try selecting text using a mouse, or select all text using Edit  “Select All” from the 
Acrobat menu. 
If No, this is an image file and is not accessible. Covert to text using View  Tools  “Recognize 
Text.” 
Step 2. Is document tagged? 
How to test: Go to File Properties (Ctrl+D in Windows, Command+D in Mac). In the bottom left 
corner of the Document Properties dialog, see the “Tagged PDF” field. 

https://webaim.org/techniques/acrobat/acrobat
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Figure 1. PDF Properties 

If No, this document needs to be tagged. Tags provide the structure on which accessibility is built. 
Add tags by selecting View  Tools v Accessibility  “Add Tags To Document.” 
Step 3. Check for any lingering errors. 
How to test: Run the accessibility checker that is built into Acrobat Pro. Select Tools  Accessibility 
 “Full Check” then read the report and follow the prompts. 

https://s3-us-west-2.amazonaws.com/uw-s3-cdn/wp-content/uploads/sites/54/2014/01/06144442/Adobe-Document-Properties1.png
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Figure 2. The results of the Accessibility Checker in Adobe Acrobat Pro 

The report lists items in various categories such as Document, Page Content, etc. Each item is 
preceded by an icon indicating that the item either passes, fails, or requires manual inspection. Right 
click on any item to see a list of options for fixing the problem or learning more about it. 
This is the final step in our checklist, rather than the first step, because some documents generate 
dozens of errors that can easily be addressed with the first two steps. This way, the accessibility 
checker will report fewer problems and will be easier to read and work with (University of Washington, 
2021). 

2.3. PDF Accessibility Checkers 

During the research on the abilities provided by various PDF Accessibility Checkers, the the InSIDE 
UOA project team reached the following conclusions on some of the most widely used PDF 
Accessibility Checkers. 

2.3.1. PAVE 
• It is an online PDF Accessibility Checkers 
• Here, you can find instructions on how to use PAVE Accessibility Checker. 
• You can check files of maximum size: 5 MB 

https://pave-pdf.org/?lang=en
https://www.youtube.com/watch?v=zV74gxcwQ58&ab_channel=ZHAW-InIT-ICTAccessbilityLab
https://s3-us-west-2.amazonaws.com/uw-s3-cdn/wp-content/uploads/sites/54/2014/01/30105338/Acrobat-accessibility-checker.png
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• It provides detailed presentation of file accessibility errors 
• It provides automatic correction of some file accessibility errors 
• It provides automatic definition of element types 
• It has the ability to manually correct accessibility errors/modify the file, by clicking on each 

item that appears on the issues list. 
• It provides easy detection and correction of accessibility errors (by highlighting the 

sentence) 
• It checks the reading order of a file. 

 
Figure 3. PAVE Accessibility Checker 
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Figure 4. PAVE Accessibility Checker - Upload File 

2.3.2. Tingtun 
• You can check files of maximum size: 10 MB 
• It does not display file accessibility errors in detail 
• It does not display the places where file accessibility errors are present. 

 

Figure 5. Tingtun PDF Accessibility Checker 

2.3.3. PAC 3 
• It is a portable PDF Accessibility Checkers 
• It has the ability of summarizing and presenting file accessibility errors in detail 
• It provides summary report as a PDF 
• It provides screen reader preview 
• It checks the logical structure of a file 
• It provides document statistics. 

http://checkers.eiii.eu/en/pdfcheck/
https://www.access-for-all.ch/en/pdf-accessibility-checker.html
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Figure 6. PAC 3 PDF Accessibility Checker 

2.3.4. Adobe Acrobat Pro DC Accessibility Checker 
The accessibility checking tools in Adobe Acrobat Pro DC -Accessibility Checker (Full Check) and 
the Make Accessible action wizard- can identify many issues in PDF documents that may be in 
conflict with Adobe’s interpretations of the accessibility guidelines referenced in the application and 
its documentation. These tools do not check documents for all accessibility criteria, including those 
in such referenced guidelines, and Adobe does not warrant that documents comply with any specific 
guidelines or regulations (Adobe, 2021). 

https://acrobat.adobe.com/us/en/acrobat.html
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Figure 7. Using the Acrobat Pro DC Accessibility Checker 

2.3.5. axesPDF QuickFix 
• Here, you can find instructions on how to use axesPDF QuickFix Accessibility Checker. 

https://www.axes4.com/axespdf-quickfix-overview.html
https://www.youtube.com/watch?v=g73P0hmrO_o&ab_channel=axespdf
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Figure 8. axesPDF QuickFix Accessibility Checker 

2.4. Google Docs Accessibility Checkers 

2.4.1. Grackle Docs 
Grackle Docs is an add-on that runs in Google Docs. 
When opened, it scans the current document for accessibility issues. It runs automatically when that 
document is opened in the future. 
When the scan finishes, Grackle Docs arranges the document’s elements and structures into 6 
categories: 

• Document 
• Images 
• Headings 
• Tables 
• Landmarks 
• Content 

These categories can be seen in the user interface on the right side of the screen. 
Elements in each are marked as either accessible or inaccessible. Changes are made by selecting 
and editing these elements in these categories. For example, a table does not have the header row 
specified with a tag. When an element is changed with Grackle Docs, it edits the tags for that element 
in the document. This edit is immediate, and no saving is required (grackle Docs, 2021). 

• It provides detailed presentation of file accessibility errors 
• It corrects automatically some file accessibility errors 
• It provides easy detection and guidelines on how to correct accessibility errors 
• It is provided a trial version of the product for a thirty-days time period. 

https://www.grackledocs.com/
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Figure 9. Grackle Docs Accessibility Checker 
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3. Moodle Accessibility 

Moodle is designed to be accessible by default to the widest possible audience. This means that 
both the application and the content is designed to be perceivable, operable, understandable and 
robust according to the definitions provided by WCAG 2.0 (Holland & Plana, 2018). 

3.1. Accessibility principles 

Based on WCAG 2.0, the four main guiding principles of accessibility are: 

• Perceivable 
• Operable 
• Understandable 
• Robust 

Conveniently, these principles spell out an acronym that is relatively easy to remember: POUR. The 
idea is to create a POUR web site, so to speak. The pun may be a bad one, but if it helps developers 
memorize the principles, then it has served its purpose. Each of these principles is discussed more 
in the sections that follow (WebAIM, 2013). These principles also apply to documents on the web, 
especially educational material. 

3.1.1. Perceivable 
Any discussion of web accessibility is based upon the assumption that people need to be able to 
perceive web content. They need to be able to input the information into their brain so that they can 
process it. If the information cannot get into the brain, it is inaccessible. As obvious as that statement 
may sound, it is a principle which is frequently ignored by developers. Too many sites contain web 
content that cannot even be perceived by some of the people who would like to access it. 

3.1.2. Operable 
Not everyone uses a standard keyboard and mouse to access the web. Some people use adaptive 
devices or alternative devices that accommodate their disabilities. Some people simply prefer to use 
the alternative technologies. While this may not seem like an important point at first, consider the 
fact that some web content can be operated only with a mouse. Mouse-dependent web content will 
be inaccessible to a person cannot use a standard mouse, due to tremors, insufficient fine motor 
control, or even a lack of hands altogether. 
Users should be able to find, navigate through, and interact with web content. Search features, site 
indexes, and site maps allow users to locate content within a Web site. With web pages or sections 
of Web content, users should be able to bypass extraneous or irrelevant pieces of content in order 
to focus on the content of interest to them. They should be able discern the structure of the content 
by its headings, subsections, bulleted lists, and other elements of semantic markup. In other words, 
the content itself should be navigable or operable by multiple methods (WebAIM, 2013). 

3.1.3. Understandable 
Understandability can be just as big a barrier to accessibility as any of the more technical issues. 
Talking about understandability moves the discussion into the broader realm of usability. Usability 
became a hot topic in the late nineties and early 21st century. It still is a hot topic but has moved from 
being a fringe fad to being a topic of mainstream conversation among web developers. 
The functionality of web content must also be understandable. Users must be able to understand all 
navigation and other forms of interaction. On static web sites, the interaction may be limited to 
hypertext links. In more complex Web content, the interaction can be extremely complex, requiring 
the user to pass through multiple steps or stages, to make decisions along the way, input information, 
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confirm information, and so on. Every point of interaction deserves attention in order to give users 
the best experience possible. If users do not understand any of the points of interaction, they may 
not be able to complete the necessary tasks on that web site (WebAIM, 2013). 

3.1.4. Robust 
Not everyone uses the same technologies now, nor will they in the future. People use different 
operating systems, different browsers, and different versions of browsers. Some people have 
advanced features enabled. Others have these features turned off. Some people are early adopters 
of new technologies. Others are slow to adapt to the rapidly-changing currents in the flow of 
technological advances. 
Despite the differences between users and the technologies they use, they all expect the web to 
work. When they go to a site that uses methods not supported by their technologies, they get 
frustrated and may never return. In the past it was common to see sites optimized for certain 
browsers or versions of browsers. Fortunately, most developers now try to develop their content so 
that it will work in many versions of many browsers. 
Users should be allowed to choose their own technologies to access web content. This allows the 
users to customize their technologies to meet their needs, including accessibility needs. Web content 
that requires a certain technology, such as a certain browser or screen reader, may exclude some 
types of users who either do not want to use that technology or cannot use it because of their 
disability. As a general rule, the more control the user has, the more likely the user will be able to 
access the content effectively. 
Of course, there are limits to this logic. Many technologies and web accessibility techniques are not 
supported in older browsers and screen readers. Modern web developers should not be forced to 
develop to the "lowest common denominator". Developers can and should feel free to take 
advantage of technological advances, including in areas related to accessibility. When considering 
implementation of innovative technologies and techniques, they must strike a balance between 
pushing innovation boundaries and considering the technologies their end users will be using. 
Developers can set a baseline of requirements. For example, they could decide to fully support 
browsers that are four years old or newer. Users of older browsers could still access the content, but 
perhaps it would not be styled properly due to lack of support for newer features. As long as the 
baseline is not too restrictive, limiting full support to a subset of technologies is a reasonable 
approach. And, again, to the extent possible, it is still best to let the user decide which technologies 
to use (WebAIM, 2013). 

3.2. Browser access features 

In recent years, great attention has been paid to browsers design and implementation by developers 
and scientists dealing with accessibility issues and assistive technologies for people with disabilities. 
The most accessible browsers for people with disabilities and those which give more possibilities for 
content customization to these people are the following (Holland & Plana, 2018): 

• Chrome 
• Firefox 
• Edge (Microsoft) 

3.3. Content Development 

Moodle platform enables users to create and edit the content presented on the platform. This ability 
is provided to users through the tool “Atto Editor”. “Atto Editor” is a custom editor built for Moodle 
platform which fucuses on great user experience provision and also, accessible content creation. 
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Moreover, “Atto Editor” has some features which help users to check the content they create as for 
its accessibility. These features are (Holland & Plana, 2018): 

• Accessibility checker 
• Prompts when adding media 
• Feature rich equation editor (Using Mathjax.org). 

3.3.1. Atto Editor 
The Atto text editor (sometimes referred to as the “HTML editor”) has many icons to assist the user 
in entering content. Many of these icons and functions should be familiar to anyone who uses a word 
processor. Some examples of where you will see the text editor include: Editing Section headings, 
description of an activity, writing an answer to a quiz question or editing the content of many blocks. 
The default text editor in Moodle is the Atto editor, built specifically for Moodle. There is also a 
TinyMCE editor and a plain text editor. 
Text editors can be enabled, disabled or a different one set to default from Administration  Site 
administration  Plugins  Text editors  Manage editors. The order of priority may also be 
specified here. 
If more than one text editor is enabled, users can select their preferred editor via their preferences 
page in the user menu (top right) (moodle, 2021d). 

 
Figure 10. Atto Editor 
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Figure 11. Atto Editor additional options 

Some of the Atto Editor features are the following (moodle, 2021d): 

• Image copy and paste: In Moodle 3.9 onwards, images can be copied from anywhere and 
pasted into the Atto editor. For example, you can take a screenshot, copy it to your clipboard 
and then paste it into the Atto editor. 

• Image drag and drop: If your browser allows it (and if it does, you will see a message at the 
top of your screen when the editing is on) you can add images into the Atto editor simply by 
dragging them from your computer. 

 
Figure 12. Drag an image directly into the editor 

• Autosave: Text typed into the Atto editor is automatically saved if you leave the page. The 
default of 60 seconds may be changed by the administrator in Site administration  Plugins 
 Text editors  Atto HTML editor  Atto toolbar settings. If the user accidentally closes 
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the tab or otherwise leaves the form without submitting, the text in the editor will be restored 
next time he opens the page. To discard a restored draft, the user needs to cancel the form 
or press the "Undo" button in the editor. 

 
Figure 13. Autosave feature 

• Manage embedded files: This allows users to add, delete or override files embedded in 
the current text area, for example in a label or topic summary. (It complements the 
Embedded files repository) 

 

Figure 14. Manage embedded files feature 
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3.3.1.1. Atto editor toolbar 

 

Figure 15. Atto Row 1 default buttons 

1. Expand 
2. Style 
3. Bold 
4. Italic 
5. Bulleted list 
6. Numbered list 
7. Add link 
8. Unlink 
9. Add image 
10. Add smiley (if enabled) 
11. Add media 
12. Record audio 
13. Record video 
14. Manage embedded files  
15. H5P 

 

Figure 16. Atto Row 2 default buttons 

1. Underline 
2. Strikethrough 
3. Subscript 
4. Superscript 
5. Align left/centre/right 
6. Decrease/increase indent 
7. Equation editor 
8. Special character 
9. Table 
10. Clear formatting 
11. Undo/redo 
12. Accessibility checker 
13. Screenreader helper 
14. HTML/code view 

3.3.1.2. Atto Editor Accessibility Checker 
One of the tools available in the text editor is an automated accessibility checker which checks for 
some common errors in the text. These are usually things in the way the text is constructed that can 
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prevent all users from having equal access to information and functionality. The list of problems that 
the accessibility checker looks for is (moodle, 2021w): 

• Images with missing or empty alt text (unless they have decorative role and do not learning 
content) 

• Contrast of font colour and background colour meets WCAG AA guidelines 
• Long blocks of text are sufficiently broken up into headings 
• All tables require captions 
• Tables should not contain merged cells as they are difficult to navigate with screen readers 
• All tables should contain row or column headers. 

The toolbar icon is of a figure in a black circle. 

 

Figure 17. The Accessibility Checker icon 

 

Figure 18. The Accessibility Checker icon highlighted. 

The image below, shows the Accessibility Checker displaying it's results. It has identified the text 
and advises that "The colours of the foreground and background text do not have enough contrast. 
To fix this warning, change either foreground or background colour of the text so that it is easier to 
read" (WARWICK, 2019). 

 

Figure 19. Atto Editor Accessibility Checker 
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3.3.1.3. Text Accessibility Check 
Content with an accessible hierarchy and layout will be clearer for everyone to navigate and 
improves their reading experience. This can be achieved following the next tips (Holland & Plana, 
2018): 

• Use editor headings: 
o Ensure headings are nested in sequence, e.g.: H2, H3 

• Use descriptive links: 
o Instead of displaying link as https://www.youtube.com/watch?v=XXX, hide it behind 

“W3C Web Accessibility Introduction”, screen reader friendly 
• Use consistent naming (each naming should correspond to the appropriate object in the 

content) 
• Use editor lists (ordered or unordered): 

o Do not insert blank lines between list items, as this usually breaks the lists for screen 
reader users. 

3.4. Screenreader Helper 

The Screenreader Helper provides additional information about the currently selected text (e.g.: is it 
bold), as well as a listing any images or links in the text. The image below shows the Screenreader 
Helper identifying the style, links and images present in the text (WARWICK, 2019). 

 
Figure 20. Screenreader Helper 

3.5. Multimedia 

3.5.1. Image Accessibility Check 
User can add images using the editor tools, as this ensures that accessible data is prompted for. 
The steps that the user should follow to implement this process are the following (Holland & Plana, 
2018): 

• Image Alt descriptions 
• Option “Description not necessary” for decorative images, e.g.: section dividers 
• Navigational graphics, such as Home for instance, should have alt of “Home”, not “Little 

yellow house” 
• Complex images, images including in-depth information, e.g.: STEM workflows, require 

longer text explanations alongside them (too long for alts). 
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Figure 21. image properties  
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3.5.2. Multimedia Accessibility Check 
Moodle comes with “video.js” with built in support for (Holland & Plana, 2018): 

• Captions 
• Subtitles 
• Chapters 
• Descriptions. 

A Moodle user can add multimedia via inbuilt tools, as this ensures that accessible data is prompted 
for. To check the accessibility of an embedded multimedia, follow the steps below (Holland & Plana, 
2018): 

• Ensure delivery method, e.g.: video.js, is accessible 
• Use captions and/or subtitles 
• Use audio descriptions when needed, e.g.: <creak of door opening> 
• Use tools, such as YouTube, to automatically produce your captions and subtitles, and 

check! 
• Including text transcripts is very useful. 

In the following window, the user enters the hyperlink that corresponds to the specific file he/she 
wishes to upload on the platform, by clicking on "Browse repositories…". This function is completed 
when the file is being uploaded on the platform, by clicking on "Insert media". Moreover, the user 
has the ability to enter or modify the name of the file: 

 

Figure 22. Insert Media – Link 

In the following window, the user enters the hyperlink that corresponds to the video file he/she wishes 
to upload on the platform, by clicking on "Browse repositories…". This function is completed when 
the file is being uploaded on the platform, by clicking on "Insert media": 
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Figure 23. Insert Media – Video 

In the window that follows, we can see the “Display options” where the user can set the size and the 
thumbnail URL, in order to modify the video file: 

 

Figure 24. Insert Video - Display options 
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In the window that follows, we can see the “Advanced settings” where the user can enable/disable 
the following settings: 

• Show controls 
• Play automatically 
• Muted 
• Loop: 

 

Figure 25. Insert Video - Advanced setting 

In the following window, the user enters the hyperlink that corresponds to the subtitle track file he/she 
wishes to upload on the platform, by clicking on "Browse repositories…". Then, the user has the 
ability to define the language of the subtitles: 
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Figure 26. Insert Video - Subtitles and captions 

After the abovementioned settings, the file upload can be completed, by clicking on "Insert media". 

 

Figure 27. Insert Video – Subtitles 
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3.6. Tables 

If someone wants to add a table in a Moodle web page should follow the steps below (Holland & 
Plana, 2018): 

• Keep them simple and logical 
• Use captions 
• Use column/row headers 
• Do not merge cells 
• Do not use for page layout, only for tabular data 
• Do not use nested tables either. 

 

Figure 28. Create table 

3.6.1. Table editor settings 
Styles, colors and sizes for tables and their borders may be enabled from Administration  Site 
administration  Plugins  Test editors  Atto HTML editor  Table settings (moodle, 2021w). 

3.7. Embedding STEM (Science, Technology, Engineering, 
Mathematics) object in Moodle content 

STEM is a curriculum based on the idea of educating students in four specific disciplines — science, 
technology, engineering and mathematics — in an interdisciplinary and applied approach. Rather 
than teach the four disciplines as separate and discrete subjects, STEM integrates them into a 
cohesive learning paradigm based on real-world applications (LIVESCIENCE, 2013). 
If someone wants to embed STEM objects in his/her course implemented on Moodle platform, 
he/she should use the Atto Equation Editor, which is an Atto Editor feature. 

3.7.1. Atto Equation Editor 
If either the MathJax or the TeX notation filters are enabled (in Administration Site administration  
Plugins  Filters  Manage filters), then an equation editor button is provided in the toolbar for 
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launching the equation editor. This editor can enrich the content with the following characteristics 
(moodle, 2021w): 

• Feature rich editor 
• Great looking equations that are fully accessible to standard accessibility applications 
• Using mathjax.org to expose queries (data to be analyzed) to assistive technology. 

 

Figure 29. Equation editor 

3.7.2. Equation editor settings 
Equation editor commands may be removed, added or reordered in Administration  Site 
administration  Plugins  Text editors  Atto HTML editor  Equation editor settings (moodle, 
2021w). 
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Figure 30. Equation editor settings 
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4. Technical features of the InSIDE Moodle platform 
installation 

With the aim of achieving the installation of the Moodle platform, so that it can serve the number of 
users who were initially estimated to have access to the platform, but also to intervene by modifying 
it appropriately, the following installations and settings were made. 
“insidemoodle.di.uoa.gr” website, where Moodle platform is installed, that corresponds to IP 
195.134.65.122. The specific platform has been installed on a virtual machine (VM) on the main 
server (webapp.di.uoa.gr) of the Department of Informatics and Telecommunication of the National 
and Kapodistrian University of Athens. Referring in detail to the technical features of the main server, 
these are the following (CLOUDCONE Knowledge Center, 2021; DigitalOcean Community, 2021; 
DigitalOcean Community, 2020; moodle, 2021b; moodle, 2021d; moodle, 2021h; moodle, 2021r; 
moodle, 2021s; moodle, 2021t; moodle, 2021ab; moodle, 2021ac): 

• Disk capacity: 250GB (for the VM) 
• Memory size: from 4GB to 8GB 
• Unix Software: Ubuntu 18.04.5 LTS (kernel version 4.15.0-124-generic) 
• PHP version: PHP 7.2.24-0ubuntu0.18.04.7 
• PHP extension: php7.2-mbstring 
• MySQL version: 14.14 Distrib 5.7.32 
• Apache Http Server version: 2.4.29 
• Firewall polices: Configured by UFW, so as to permit SSH connections and also, HTTP 

connections on port 80 (hostadvice, 2021) 
• phpMyAdmin (MySQL administration tool), installed in: insidemoodle.di.uoa.gr/phpMyAdmin 
• Moodle version: 3.9 
• Moodle server path: /var/www/html 

 
Figure 31. Moodle server path 

http://insidemoodle.di.uoa.gr/
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• Error logs path: /var/log/apache2/error.log 

 
Figure 32. Error logs path 

The folder “moodledata” in path “/var/moodledata” with open external permissions (777) has also 
been created, in order the downloads to be permitted: drwxrwxrwx 10 www-data www-data 4096 
Dec 2 12:12 moodledata/ 
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Figure 33. Moodledata path 

Finally, internal downloads are set to get permission 750 for more privacy, e.g.: drwxr-x--- 7 www-
data www-data 4096 Dec 2 12:11 filedir/ 
The connection to the virtual machine "insidemoodle.di.uoa.gr" can be realized by using SSH (e.g.: 
PuTTY) or FTP (e.g.: FileZilla). 
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5. Modification of Moodle to improve its accessibility 

The main contribution of the InSIDE UOA project team for the abovementioned improvement 
consists of two parts. The first one is the implementation of a webpage which is named “Instructions 
for Creating Accessible Files” and contains instructions for creating accessible files (see Appendix 
3-10). On this website, the scientific team has created internal webpages, which correspond to the 
three categories of instructions: 

• Documents: Quick guidelines for creating accessible documents 
• Presentations: Quick guidelines for creating accessible presentations 
• Video / Audio: Quick guidelines for creating accessible video/audio files 

 
Figure 34. Instructions for Creating Accessible Files – Webpage – Documents 

 

Figure 35. Instructions for Creating Accessible Files – Webpage – Presentations 

http://insidemoodle.di.uoa.gr/course/view.php?id=5
http://insidemoodle.di.uoa.gr/course/view.php?id=5
http://insidemoodle.di.uoa.gr/mod/page/view.php?id=70
http://insidemoodle.di.uoa.gr/mod/page/view.php?id=71
http://insidemoodle.di.uoa.gr/mod/page/view.php?id=68
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Figure 36. Instructions for Creating Accessible Files – Webpage - Video/Audio 

In these webpages the InSIDE UOA project team embedded guidelines for creating accessible 
documents, presentations and video/audio files created by the members of the team. 
Additionally, the scientific team has set the opening of each instruction file so that it opens in a new 
tab. This facilitates the user, because it allows him to modify his files in an accessible way, while 
being consulted by the relevant instructions, created in the context of this intervention. 
The access to the main webpage is possible from the custom menu, which was created in the upper 
left part of the website, as well as from "Site home", and from the accessibility warning message 
links; the accessibility warning utility and description will be presented below. 

 
Figure 37. Access to the main accessibility webpage from the custom menu item 

http://insidemoodle.di.uoa.gr/
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Figure 38. Access to the main accessibility webpage from the "Site home" 

The second part of the main intervention created by the the InSIDE UOA project team is the addition 
of an accessibility warning message at all points that the user has the ability to upload a file. The 
scientific team has made a research on possible scenarios in which a file can be uploaded, identifying 
the activities and the resources where this process is feasible. 

5.1. Process of creating the webpages with the guidelines for 
creating accessible documents (see Appendix 3-10) 

First of all, the InSIDE UOA project team created guidelines for creating accessible various formats 
of documents and presentations. Then, these guidelines converted into PDF and moreover, they 
have been added into separate webpages, based on the specific category of each guidelines using 
the page module that enables someone to create a web page resource using the text editor. A page 
can display text, images, sound, video, web links and embedded code, such as Google maps. The 
advantages of using the page module rather than the file module include the resource being more 
accessible (for example to users of mobile devices) and easier to update. 
Below, there are some screenshots of the content addition and editing process using the “Atto Editor” 
for creating the abovementioned guidelines. 
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Figure 39. The Page Module 

 
Figure 40. The editing page for adding the guidelines for creating accessible documents 
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Figure 41. The editing of the content section for adding the guidelines for creating accessible documents 

 
Figure 42. The editing page for adding the guidelines for creating accessible presentations 

 
Figure 43. The editing of the content section for adding the guidelines for creating accessible presentations 

5.2. Accessibility Warning 

In the Accessibility warning, the InSIDE UOA project team has added the categories of instructions 
in the form of buttons with links to the corresponding webpages that contain the instructions of each 
accessibility file creation category. 

 
Figure 44. The accessibility warning message 

The scientific team has set the webpage to open in a separate tab, so that the form stands by for the 
user to upload an accessible file. 
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Figure 45. The accessibility warning message in the upload file manager field 

 
Figure 46. The code for creating the accessibility warning message 

Trying to struct the final version of the accessibility warning message, the InSIDE UOA project team 
performed the following tests: 

 
Figure 47. The accessibility warning message - Version 1 

 
Figure 48. The accessibility warning message - Version 2 

 
Figure 49. The accessibility warning message - Version 3 
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Figure 50. The accessibility warning message - Version 4 

 
Figure 51. The accessibility warning message - Version 5 

The intervention carried out by the InSIDE UOA project team affects the operation of those of the 
Moodle Activities and Resources through which a file can be uploaded. All the Moodle Activities and 
Resources are presented in detail in the next section. 
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5.3. Moodle Activities & Resources 

 
Figure 52. Moodle Activities & Resources 

5.3.1. Activities 
An activity is a general name for a group of features in a Moodle course. Usually, an activity is 
something that a student will do that interacts with other students and or the teacher. 
In Moodle terminology, an Activity, such as Forums or Quizzes, properly means something students 
can contribute to directly, and is often contrasted to a Resource such as a File or Page, which is 
presented by the teacher to them. However, the term activity is sometimes for convenience also 
used to refer to both Activities and Resources as a group. 
There are 14 different types of activities in the standard Moodle that can be found when the editing 
is turned on and the link 'Add an activity or resource' is clicked (moodle, 2021a). 

5.3.1.1. Assignments 
The assignment activity module enables a teacher to communicate tasks, collect work and provide 
grades and feedback. 
Students can submit any digital content (files), such as word-processed documents, spreadsheets, 
images, or audio and video clips. Alternatively, or in addition, the assignment may require students 



InSIDE project Page 
52 

WP3: Development 

2018-3218 /001-001 Deliverable DEV3.3 Adaptations and Delivery of LMS platform  

 

to type text directly into the text editor. An assignment can also be used to remind students of 'real-
world' assignments they need to complete offline, such as art work, and thus not require any digital 
content. Students can submit work individually or as a member of a group. 
When reviewing assignments, teachers can leave feedback comments and upload files, such as 
marked-up student submissions, documents with comments or spoken audio feedback. 
Assignments can be graded using a numerical or custom scale or an advanced grading method such 
as a rubric. Final grades are recorded in the gradebook (moodle, 2021c). 

5.3.1.2. Chat 
The chat activity module enables participants to have text-based, real-time synchronous 
discussions. 
The chat may be a one-time activity or it may be repeated at the same time each day or each week. 
Chat sessions are saved and can be made available for everyone to view or restricted to users with 
the capability to view chat session logs. 
Chats are especially useful when the group chatting is not able to meet face-to-face, such as 
(moodle, 2021f): 

• Regular meetings of students participating in online courses to enable them to share 
experiences with others in the same course but in a different location 

• A student temporarily unable to attend in person chatting with their teacher to catch up with 
work 

• Students out on work experience getting together to discuss their experiences with each 
other and their teacher 

• Younger children using chat at home in the evenings as a controlled (monitored) introduction 
to the world of social networking 

• A question and answer session with an invited speaker in a different location 
• Sessions to help students prepare for tests where the teacher, or other students, would pose 

sample questions 

5.3.1.3. Choice 
The choice activity module enables a teacher to ask a single question and offer a selection of 
possible responses. 
Choice results may be published after students have answered, after a certain date, or not at all. 
Results may be published with student names or anonymously (though teachers always see student 
names and their responses). 
A choice activity may be used (moodle, 2021g): 

• As a quick poll to stimulate thinking about a topic 
• To quickly test students' understanding 
• To facilitate student decision-making, for example allowing students to vote on a direction for 

the course 

5.3.1.4. Database 
The database activity module enables participants to create, maintain and search a collection of 
entries (e.g.0: records). The structure of the entries is defined by the teacher as a number of fields. 
Field types include checkbox, radio buttons, drop-down menu, text area, URL, picture and uploaded 
file. 
The visual layout of information when listing, viewing or editing database entries may be controlled 
by database templates. Database activities may be shared between courses as presets and a 
teacher may also import and export database entries. 
If the database auto-linking filter is enabled, any entries in a database will be automatically linked 
where the words or phrases appear within the course. 
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A teacher can allow comments on entries. Entries can also be rated by teachers or students (peer 
evaluation). Ratings can be aggregated to form a final grade which is recorded in the gradebook. 
Database activities have many uses, such as (moodle, 2021h): 

• A collaborative collection of web links, books, book reviews, journal references etc. 
• For displaying student-created photos, posters, websites or poems for peer comment and 

review. 
5.3.1.5. Feedback 

The feedback activity module enables a teacher to create a custom survey for collecting feedback 
from participants using a variety of question types including multiple choice, yes/no or text input. 
Feedback responses may be anonymous if desired, and results may be shown to all participants or 
restricted to teachers only. Any feedback activities on the site front page may also be completed by 
non-logged-in users. 
Feedback activities may be used (moodle, 2021j): 

• For course evaluations, helping improve the content for later participants 
• To enable participants to sign up for course modules, events etc. 
• For guest surveys of course choices, school policies etc. 
• For anti-bullying surveys in which students can report incidents anonymously 
5.3.1.6. Forum 

The forum activity module enables participants to have asynchronous discussions i.e.: discussions 
that take place over an extended period of time. 
There are several forum types to choose from, such as a standard forum where anyone can start a 
new discussion at any time; a forum where each student can post exactly one discussion; or a 
question and answer forum where students must first post before being able to view other students' 
posts. A teacher can allow files to be attached to forum posts. Attached images are displayed in the 
forum post. 
Participants can subscribe to a forum to receive notifications of new forum posts. A teacher can set 
the subscription mode to optional, forced or auto, or prevent subscription completely. If required, 
students can be blocked from posting more than a given number of posts in a given time period; this 
can prevent individuals from dominating discussions. 
Forum posts can be rated by teachers or students (peer evaluation). Ratings can be aggregated to 
form a final grade which is recorded in the gradebook. 
Forums have many uses, such as (moodle, 2021n): 

• A social space for students to get to know each other 
• For course announcements (using a news forum with forced subscription) 
• For discussing course content or reading materials 
• For continuing online an issue raised previously in a face-to-face session 
• For teacher-only discussions (using a hidden forum) 
• A help center where tutors and students can give advice 
• A one-on-one support area for private student-teacher communications (using a forum with 

separate groups and with one student per group) 
• For extension activities, for example ‘brain teasers’ for students to ponder and suggest 

solutions to 

5.3.1.7. Glossary 
The glossary activity module enables participants to create and maintain a list of definitions, like a 
dictionary, or to collect and organize resources or information. 
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A teacher can allow files to be attached to glossary entries. Attached images are displayed in the 
entry. Entries can be searched or browsed alphabetically or by category, date or author. Entries can 
be approved by default or require approval by a teacher before they are viewable by everyone. 
If the glossary auto-linking filter is enabled, entries will be automatically linked where the concept 
words and/or phrases appear within the course. 
A teacher can allow comments on entries. Entries can also be rated by teachers or students (peer 
evaluation). Ratings can be aggregated to form a final grade which is recorded in the gradebook. 
Glossaries have many uses, such as (moodle, 2021o): 

• A collaborative bank of key terms 
• A ‘getting to know you’ space where new students add their name and personal details 
• A ‘handy tips’ resource of best practice in a practical subject 
• A sharing area of useful videos, images or sound files 
• A revision resource of facts to remember 
5.3.1.8. H5P activity 

H5P is an abbreviation for HTML5 Package - interactive content such as presentations, videos and 
other multimedia, questions, quizzes, games and more. The H5P activity enables H5P to be 
uploaded and added to a course. 
Any question attempts are marked automatically, and the grade is recorded in the gradebook 
(moodle, 2021p). 

5.3.1.9. Lesson 
The lesson activity module enables a teacher to deliver content and/or practice activities in 
interesting and flexible ways. A teacher can use the lesson to create a linear set of content pages or 
instructional activities that offer a variety of paths or options for the learner. In either case, teachers 
can choose to increase engagement and ensure understanding by including a variety of questions, 
such as multiple choice, matching and short answer. Depending on the student's choice of answer 
and how the teacher develops the lesson, students may progress to the next page, be taken back to 
a previous page or redirected down a different path entirely. 
A lesson may be graded, with the grade recorded in the gradebook. 
Lessons may be used (moodle, 2021v): 

• For self-directed learning of a new topic 
• For scenarios or simulations/decision-making exercises 
• For differentiated revision, with different sets of revision questions depending upon answers 

given to initial questions 
5.3.1.10. (LTI) External tool 

The external tool activity module enables students to interact with learning resources and activities 
on other web sites. For example, an external tool could provide access to a new activity type or 
learning materials from a publisher. 
To create an external tool activity, a tool provider which supports LTI (Learning Tools Interoperability) 
is required. A teacher can create an external tool activity or make use of a tool configured by the site 
administrator. 
External tool activities differ from URL resources in a few ways (moodle, 2021i): 

• External tools are context aware e.g.: they have access to information about the user who 
launched the tool, such as institution, course and name 

• External tools support reading, updating, and deleting grades associated with the activity 
instance 
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• External tool configurations create a trust relationship between your site and the tool provider, 
allowing secure communication between them 

5.3.1.11. Quiz 
The quiz activity enables a teacher to create quizzes comprising questions of various types, including 
multiple choice, matching, short-answer and numerical. 
The teacher can allow the quiz to be attempted multiple times, with the questions shuffled or 
randomly selected from the question bank. A time limit may be set. 
Each attempt is marked automatically, with the exception of essay questions, and the grade is 
recorded in the gradebook. 
The teacher can choose when and if hints, feedback and correct answers are shown to students. 
Quizzes may be used (moodle, 2021x): 

• As course exams 
• As mini tests for reading assignments or at the end of a topic 
• As exam practice using questions from past exams 
• To deliver immediate feedback about performance 
• For self-assessment 
5.3.1.12. SCORM 

A SCORM package is a collection of files which are packaged according to an agreed standard for 
learning objects. The SCORM activity module enables SCORM or AICC packages to be uploaded 
as a zip file and added to a course. 
Content is usually displayed over several pages, with navigation between the pages. There are 
various options for displaying content in a pop-up window, with a table of contents, with navigation 
buttons etc. SCORM activities generally include questions, with grades being recorded in the 
gradebook. 
SCORM activities may be used (moodle, 2021aa): 

• For presenting multimedia content and animations 
• As an assessment tool 
5.3.1.13. Survey 

The survey activity module provides a number of verified survey instruments that have been found 
useful in assessing and stimulating learning in online environments. A teacher can use these to 
gather data from their students that will help them learn about their class and reflect on their own 
teaching. 
Note that these survey tools are pre-populated with questions. Teachers who wish to create their 
own survey should use the feedback activity module (moodle, 2021ad). 

5.3.1.14. Wiki 
The wiki activity module enables participants to add and edit a collection of web pages. A wiki can 
be collaborative, with everyone being able to edit it, or individual, where everyone has their own wiki 
which only they can edit. 
A history of previous versions of each page in the wiki is kept, listing the edits made by each 
participant. 
Wikis have many uses, such as (moodle, 2021af): 

• For group lecture notes or study guides 
• For members of a faculty to plan a scheme of work or meeting agenda together 
• For students to collaboratively author an online book, creating content on a topic set by their 

tutor 
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• For collaborative storytelling or poetry creation, where each participant writes a line or verse 
• As a personal journal for examination notes or revision (using an individual wiki) 
5.3.1.15. Workshop 

The workshop activity module enables the collection, review and peer assessment of students' work. 
Students can submit any digital content (files), such as word-processed documents or spreadsheets 
and can also type text directly into a field using the text editor. 
Submissions are assessed using a multi-criteria assessment form defined by the teacher. The 
process of peer assessment and understanding the assessment form can be practiced in advance 
with example submissions provided by the teacher, together with a reference assessment. Students 
are given the opportunity to assess one or more of their peers' submissions. Submissions and 
reviewers may be anonymous if required. 
Students obtain two grades in a workshop activity - a grade for their submission and a grade for their 
assessment of their peers' submissions. Both grades are recorded in the gradebook (moodle, 
2021ah). 

5.3.2. Resources 
A resource is an item that a teacher can use to support learning, such as a file or link. Moodle 
supports a range of resource types which teachers can add to their courses. In edit mode, a teacher 
can add resources via the 'Add an activity or resource' link. Resources appear as a single link with 
an icon in front of it that represents the type of resource. 
Administrators can decide whether or not to force teachers to add descriptions for each resource by 
enabling or disabling a site-wide setting in Administration > Plugins > Activity modules > Common 
settings (moodle, 2021z). 

5.3.2.1. Book 
The book module enables a teacher to create a multi-page resource in a book-like format, with 
chapters and subchapters. Books can contain media files as well as text and are useful for displaying 
lengthy passages of information which can be broken down into sections. 
A book may be used (moodle, 2021e): 

• To display reading material for individual modules of study 
• As a staff departmental handbook 
• As a showcase portfolio of student work 
5.3.2.2. File 

The file module enables a teacher to provide a file as a course resource. Where possible, the file will 
be displayed within the course interface; otherwise students will be prompted to download it. The file 
may include supporting files, for example an HTML page may have embedded images. 
Note that students need to have the appropriate software on their computers in order to open the 
file. 
A file may be used (moodle, 2021k): 

• To share presentations given in class 
• To include a mini website as a course resource 
• To provide draft files of software programs so students can edit and submit them for 

assessment 
5.3.2.3. Folder 

The folder module enables a teacher to display a number of related files inside a single folder, 
reducing scrolling on the course page. A zipped folder may be uploaded and unzipped for display, 
or an empty folder created and files uploaded into it. 
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A folder may be used (moodle, 2021m): 

• For a series of files on one topic, for example a set of past examination papers in pdf format 
or a collection of image files for use in student projects 

• To provide a shared uploading space for teachers on the course page (keeping the folder 
hidden so that only teachers can see it) 

5.3.2.4. IMS content package 
An IMS content package is a collection of files which are packaged according to an agreed standard 
so they can be reused in different systems. The IMS content package module enables such content 
packages to be uploaded as a zip file and added to a course as a resource. 
Content is usually displayed over several pages, with navigation between the pages. There are 
various options for displaying content in a pop-up window, with a navigation menu or buttons etc. 
An IMS content package may be used for presenting multimedia content and animations (moodle, 
2021q). 

5.3.2.5. Label 
The label module enables text and multimedia to be inserted into the course page in between links 
to other resources and activities. Labels are very versatile and can help to improve the appearance 
of a course if used thoughtfully. 
Labels may be used (moodle, 2021u): 

• To split up a long list of activities with a subheading or an image 
• To display an embedded sound file or video directly on the course page 
• To add a short description to a course section 
5.3.2.6. Page 

The page module enables a teacher to create a web page resource using the text editor. A page can 
display text, images, sound, video, web links and embedded code, such as Google maps. 
Advantages of using the page module rather than the file module include the resource being more 
accessible (for example to users of mobile devices) and easier to update. 
For large amounts of content, it's recommended that a book is used rather than a page. 
A page may be used (moodle, 2021z): 

• To present the terms and conditions of a course or a summary of the course syllabus 
• To embed several videos or sound files together with some explanatory text 
5.3.2.7. URL 

The URL module enables a teacher to provide a web link as a course resource. Anything that is 
freely available online, such as documents or images, can be linked to; the URL does not have to 
be the home page of a website. The URL of a particular web page may be copied and pasted or a 
teacher can use the file picker and choose a link from a repository such as Flickr, YouTube or 
Wikimedia (depending upon which repositories are enabled for the site). 
There are a number of display options for the URL, such as embedded or opening in a new window 
and advanced options for passing information, such as a student's name, to the URL if required. 
Note that URLs can also be added to any other resource or activity type through the text editor 
(moodle, 2021ae). 

5.4. Additional interventions on Moodle platform 

Some additional interventions made for the proper operation of the Moodle platform include changing 
the maximum size of the uploading file, creation of custom menu item for accessing the lesson and 
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adding a platform’s logo (see Appendix 1) and the settings that affect the platform language 
packages. 
Moreover, the InSIDE UOA project team removed the user ability to switch languages so that the 
only and default language of this Moodle version to be English. 
That was achieved by appropriately changing the following settings (path): Dashboard / Site 
administration / Language / Language settings 

• Language autodetect  Off (Default: Yes) 
• Default language  English (en) (Default: English (en)) 
• Display language menu  Off (Default: Yes) 

 
Figure 53. Modifications on Moodle platform "Language settings" 

Furthermore, all the other language packs except English were removed. 
This result was achieved by performing the following procedure (path): “Language import utility” 
Dashboard / Site administration / Language / Language packs 

• Installed language packs  English (en) 

 
Figure 54. Modifications on Moodle platform "Language packs" 

Finally, the InSIDE UOA project team converted the font-family of the platform’s main part into “Arial”, 
which is one of the most accessible font-families. 
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Figure 55. Conversion of font-family into "Arial" 

To make it easier for users to find guidelines for creating accessible files from anywhere on the 
Moodle platform, the InSIDE UOA project team embedded the following custom menu. If you want 
to see how the modification was made, see Appendix 1. 
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Figure 56. The custom menu item 

According to the website’s logo, we have made the following modification on Moodle platform, so as 
to be so as the identity of the InSIDE website to be visible for the users. 

 
Figure 57. InSIDE Moodle platform's logo - Login page 
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Figure 58. Modification on Moodle platform's logo appearance 

 
Figure 59. InSIDE Moodle platform's logo 
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Figure 60. Instructions for Creating Accessible Files InSIDE logo 

   



InSIDE project Page 
63 

WP3: Development 

2018-3218 /001-001 Deliverable DEV3.3 Adaptations and Delivery of LMS platform  

 

6. References 

Adobe. (2021). Using the Acrobat Pro DC Accessibility Checker. Retrieved 8th April, 2021, from 
https://www.adobe.com/accessibility/products/acrobat/using-acrobat-pro-accessibility-checker.html 

CLOUDCONE: Knowledge Center. (2021). How To Install Moodle On Ubuntu 18.04. Retrieved 19th 
April, 2021, from https://cloudcone.com/docs/article/how-to-install-moodle-on-ubuntu-18-04/ 

DigitalOcean Community. (2021). How To Install MySQL on Ubuntu 18.04. Retrieved 19th April, 
2021, from https://www.digitalocean.com/community/tutorials/how-to-install-mysql-on-ubuntu-18-04 

DigitalOcean Community. (2020). How To Install and Secure phpMyAdmin on Ubuntu 18.04. 
Retrieved 19th April, 2021, from https://www.digitalocean.com/community/tutorials/how-to-install-
and-secure-phpmyadmin-on-ubuntu-18-04 

eThink. (2018). ACCESSIBILITY IN MOODLE. Retrieved 15th February, 2021, from 
https://ethinkeducation.com/blog/accessibility-in-moodle/ 

grackle Docs. (2021). How Grackle Docs Works. Retrieved 8th April, 2021, from 
https://www.grackledocs.com/how-it-works/ 

Holland, K., & Plana, P. (2018). Moodle: Accessibility the easy way. Retrieved 7th January, 2021, 
from https://moodle.com/wp-content/events/mootglobal18/day3/Moodle-and-Accessibility-
MootES18.pdf 

hostadvice. (2021). How to Configure Firewall with UFW on Ubuntu 18.04. Retrieved 16th April, 
2021, from https://hostadvice.com/how-to/how-to-configure-firewall-with-ufw-on-ubuntu-18/ 

Hubken group. (2021). How to make use of the Custom Menu feature in Moodle (2021 Update). 
Retrieved 24th April, 2021, from https://www.hubkengroup.com/resources/custom-menu-feature-
moodle 

Kouroupetroglou, G, N. Oikonomidis, A. Bruce, N. O�Sullivan, R. Bos-Wierda, R. Barendsen, K. 
Riviou, D. Deligiorgi: “ The universal design for learning good practices inventory” The Turkish 
online Journal of Educational Technology, pp. 646-653, Sept. 2015 

Koustriava, E., Papadopoulos, K., Charitakis, K., Salinas, V., Miesenberger, K., Kouroupetroglou, 
G., & Pino, A. (2020). Including Students with Disabilities in Distance Education. In A. Petz, K. 
Miesenberger (Eds.), Future Perspectives of AT, eAccessibility and eInclusion (1st digital edition of 
the ICCHP open access compendium), pp. 153-157, ISBN 978-3-9504630-2-6, Association 
ICCHP, Linz, available online. 

LIVESCIENCE. (2013). What is STEM Education? Retrieved 19th May, 2021, from 
https://www.livescience.com/43296-what-is-stem-education.html 

moodle. (2021a). Activities. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/Activities 

moodle. (2021b). admin/environment/php extension/intl. Retrieved 19th April, 2021, from 
https://docs.moodle.org/23/en/admin/environment/php_extension/intl 

moodle. (2021c). Assignment activity. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/Assignment_activity 

moodle. (2021d). Atto editor. Retrieved 6th April, 2021, from 
https://docs.moodle.org/310/en/Atto_editor#Accessibility_checker 

https://www.adobe.com/accessibility/products/acrobat/using-acrobat-pro-accessibility-checker.html
https://cloudcone.com/docs/article/how-to-install-moodle-on-ubuntu-18-04/
https://www.digitalocean.com/community/tutorials/how-to-install-mysql-on-ubuntu-18-04
https://www.digitalocean.com/community/tutorials/how-to-install-and-secure-phpmyadmin-on-ubuntu-18-04
https://www.digitalocean.com/community/tutorials/how-to-install-and-secure-phpmyadmin-on-ubuntu-18-04
https://ethinkeducation.com/blog/accessibility-in-moodle/
https://www.grackledocs.com/how-it-works/
https://moodle.com/wp-content/events/mootglobal18/day3/Moodle-and-Accessibility-MootES18.pdf
https://moodle.com/wp-content/events/mootglobal18/day3/Moodle-and-Accessibility-MootES18.pdf
https://hostadvice.com/how-to/how-to-configure-firewall-with-ufw-on-ubuntu-18/
https://www.hubkengroup.com/resources/custom-menu-feature-moodle
https://www.hubkengroup.com/resources/custom-menu-feature-moodle
https://speech.di.uoa.gr/sppages/spppdf/2015_UDL_Inventory_Kouroupetroglou_et_al.pdf
https://www.icchp.org/sites/default/files/ED_1_ICCHP_Forum.pdf
https://www.livescience.com/43296-what-is-stem-education.html
https://docs.moodle.org/39/en/Activities
https://docs.moodle.org/23/en/admin/environment/php_extension/intl
https://docs.moodle.org/39/en/Assignment_activity
https://docs.moodle.org/310/en/Atto_editor#Accessibility_checker


InSIDE project Page 
64 

WP3: Development 

2018-3218 /001-001 Deliverable DEV3.3 Adaptations and Delivery of LMS platform  

 

moodle. (2021e). Book resource. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/Book_resource 

moodle. (2021f). Chat activity. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/Chat_activity 

moodle. (2021g). Choice activity. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/Choice_activity 

moodle. (2021h). Database activity. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/Database_activity 

moodle. (2021i). External tool. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/External_tool 

moodle. (2021j). Feedback activity. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/Feedback_activity 

moodle. (2021k). File resource. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/File_resource 

moodle. (2021l). File upload size. Retrieved 24th April, 2021, from 
https://docs.moodle.org/310/en/File_upload_size 

moodle. (2021m). Folder resource. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/Folder_resource 

moodle. (2021n). Forum activity. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/Forum_activity 

moodle. (2021o). Glossary activity. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/Glossary_activity 

moodle. (2021p). H5P activity. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/H5P_activity 

moodle. (2021q). IMS content package. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/IMS_content_package 

moodle. (2021r). Installation quick guide. Retrieved 19th April, 2021, from 
https://docs.moodle.org/39/en/Installation_quick_guide 

moodle. (2021s). Installation on Ubuntu using Git. Retrieved 19th April, 2021, from 
https://docs.moodle.org/39/en/Installation_on_Ubuntu_using_Git 

moodle. (2021t). Installing Moodle. Retrieved 19th April, 2021, from 
https://docs.moodle.org/39/en/Installing_Moodle 

moodle. (2021u). Label. Retrieved 24th April, 2021, from https://docs.moodle.org/39/en/Label 

moodle. (2021v). Lesson activity. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/Lesson_activity 

moodle. (2021w). MySQL. Retrieved 19th April, 2021, from https://docs.moodle.org/39/en/MySQL 

moodle. (2021x). Page resource. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/Page_resource 

https://docs.moodle.org/39/en/Book_resource
https://docs.moodle.org/39/en/Chat_activity
https://docs.moodle.org/39/en/Choice_activity
https://docs.moodle.org/39/en/Database_activity
https://docs.moodle.org/39/en/External_tool
https://docs.moodle.org/39/en/Feedback_activity
https://docs.moodle.org/39/en/File_resource
https://docs.moodle.org/310/en/File_upload_size
https://docs.moodle.org/39/en/Folder_resource
https://docs.moodle.org/39/en/Forum_activity
https://docs.moodle.org/39/en/Glossary_activity
https://docs.moodle.org/39/en/H5P_activity
https://docs.moodle.org/39/en/IMS_content_package
https://docs.moodle.org/39/en/Installation_quick_guide
https://docs.moodle.org/39/en/Installation_on_Ubuntu_using_Git
https://docs.moodle.org/39/en/Installing_Moodle
https://docs.moodle.org/39/en/Label
https://docs.moodle.org/39/en/Lesson_activity
https://docs.moodle.org/39/en/MySQL
https://docs.moodle.org/39/en/Page_resource


InSIDE project Page 
65 

WP3: Development 

2018-3218 /001-001 Deliverable DEV3.3 Adaptations and Delivery of LMS platform  

 

moodle. (2021y). Quiz activity. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/Quiz_activity 

moodle. (2021z). Resources. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/Resources 

moodle. (2021aa). SCORM activity. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/SCORM_activity 

moodle. (2021ab). Security recommendations. Retrieved 19th April, 2021, from 
https://docs.moodle.org/39/en/Security_recommendations 

moodle. (2021ac). Step-by-step Installation Guide for Ubuntu. Retrieved 19th April, 2021, from 
https://docs.moodle.org/39/en/Step-by-step_Installation_Guide_for_Ubuntu 

moodle. (2021ad). Survey activity. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/Survey_activity 

moodle. (2021ae). URL resource. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/URL_resource 

moodle. (2021af). Using the File API in Moodle forms. Retrieved 24th April, 2021, from 
https://docs.moodle.org/dev/Using_the_File_API_in_Moodle_forms 

moodle. (2021ag). Wiki activity. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/Wiki_activity 

moodle. (2021ah). Workshop activity. Retrieved 24th April, 2021, from 
https://docs.moodle.org/39/en/Workshop_activity 

moodle. (2020a). About Moodle. Retrieved 15th February, 2021, from 
https://docs.moodle.org/310/en/About_Moodle 

moodle. (2020b). Getting started is easy. Retrieved 15th February, 2021, from 
https://moodle.org/?lang=en 

PRESSBOOKS. (2021). BEST PRACTICES IN ACCESSIBLE ONLINE DESIGN. Retrieved 19th May, 2021, from 
https://pressbooks.ulib.csuohio.edu/accessibility/chapter/chapter-2-4-formatting-font-for-readability/ 

Riviou, K. and G. Kouroupetroglou “Designing an educational scenario using the principles of 
Universal Design for Learning”, The 14th IEEE International Conference on Advanced Learning 
Technologies - ICALT2014, July 7-9, Athens, 2014 

Riviou, K, G. Kouroupetroglou and N. Oikonomidis: “A network of peers and practices for 
addressing Learner Variability: UDLnet”, Proceedings of the 13th AAATE Conference, 9-12 Sept. 
2015, Budapest, pp. 32-39 by IOS Press doi:10.3233/978-1-61499-566-1-32 

Salinas Lopez, V., Miesenberger, K., Petz, A., Kouroupetroglou, G., Koustriava, E., Papadopoulos, 
K., & Pino, A. (2020). How to Select an Accessible Learning Management System for Distance 
Education. In A. Petz, K. Miesenberger (Eds.), Future Perspectives of AT, eAccessibility and 
eInclusion (1st digital edition of the ICCHP open access compendium), pp. 159-165, ISBN 978-3-
9504630-2-6, Association ICCHP, Linz, available online. 

University of Washington. (2021). Accessible Technology. Retrieved 8th April, 2021, from 
https://www.washington.edu/accessibility/documents/overview/ 

https://docs.moodle.org/39/en/Quiz_activity
https://docs.moodle.org/39/en/Resources
https://docs.moodle.org/39/en/SCORM_activity
https://docs.moodle.org/39/en/Security_recommendations
https://docs.moodle.org/39/en/Step-by-step_Installation_Guide_for_Ubuntu
https://docs.moodle.org/39/en/Survey_activity
https://docs.moodle.org/39/en/URL_resource
https://docs.moodle.org/dev/Using_the_File_API_in_Moodle_forms
https://docs.moodle.org/39/en/Wiki_activity
https://docs.moodle.org/39/en/Workshop_activity
https://docs.moodle.org/310/en/About_Moodle
https://moodle.org/?lang=en
https://pressbooks.ulib.csuohio.edu/accessibility/chapter/chapter-2-4-formatting-font-for-readability/
https://books.google.gr/books?id=arppCgAAQBAJ&pg=PA32&lpg=PA32&dq=%22A+network+of+peers+and+practices+for+addressing+Learner+Variability:+UDLnet%22&source=bl&ots=gJR-lUo5Y0&sig=8grYgNIp4gKg_DhU2rZCxOIvDZk&hl=en&sa=X&ved=0ahUKEwiVsvCQ5rvMAhWKzRoKHdS3AagQ6AEIJjAD#v=onepage&q=%22A%20network%20of%20peers%20and%20practices%20for%20addressing%20Learner%20Variability%3A%20UDLnet%22&f=false
https://books.google.gr/books?id=arppCgAAQBAJ&pg=PA32&lpg=PA32&dq=%22A+network+of+peers+and+practices+for+addressing+Learner+Variability:+UDLnet%22&source=bl&ots=gJR-lUo5Y0&sig=8grYgNIp4gKg_DhU2rZCxOIvDZk&hl=en&sa=X&ved=0ahUKEwiVsvCQ5rvMAhWKzRoKHdS3AagQ6AEIJjAD#v=onepage&q=%22A%20network%20of%20peers%20and%20practices%20for%20addressing%20Learner%20Variability%3A%20UDLnet%22&f=false
https://doi.org/10.3233/978-1-61499-566-1-32
https://www.icchp.org/sites/default/files/ED_1_ICCHP_Forum.pdf#page=159
https://www.washington.edu/accessibility/documents/overview/


InSIDE project Page 
66 

WP3: Development 

2018-3218 /001-001 Deliverable DEV3.3 Adaptations and Delivery of LMS platform  

 

WARWICK. (2019). Using Moodle accessibility tools. Retrieved 6th July, 2021, from 
https://warwick.ac.uk/services/its/servicessupport/academictechnology/support/guides/moodle-
guides/mdl-86/ 

WebAIM. (2013). Constructing a POUR Website. Retrieved 6th April, 2021, from 
https://webaim.org/articles/pour/  

https://warwick.ac.uk/services/its/servicessupport/academictechnology/support/guides/moodle-guides/mdl-86/
https://warwick.ac.uk/services/its/servicessupport/academictechnology/support/guides/moodle-guides/mdl-86/
https://webaim.org/articles/pour/


InSIDE project Page 
67 

WP3: Development 

2018-3218 /001-001 Deliverable DEV3.3 Adaptations and Delivery of LMS platform  

 

Appendix 1: Adding a new user to Moodle platform and 
enrolling him/her in the course 

The administrator of Moodle platform has the opportunity to add new users to it following the path: 
Site administration  Users  Accounts  Add a new user. To do that, the administrator should 
have the following information, as you can see in the image below: 

• the user’s first name 
• the user’s surname 
• an email address 
• a username 
• a password, that must have at least 8 characters, at least 1 digit(s), at least 1 lower case 

letter(s), at least 1 upper case letter(s), at least 1 non-alphanumeric character(s) such as *, -
, or # 

 
Figure 61. Adding a new user to Moodle platform 

Having done this step, the administrator should enroll the users, who are going to have the role of 
the teachers in the specific course. So, he/she selects the course, and through “Participants”, clicks 
on “Enroll users”. He/She selects the user to be enrolled and his/her role, and then, he/she clicks 
again on “Enroll users”. 
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Figure 62. Enrolling a teacher in the course 

 The image below, depicts the participants of a course: 

 
Figure 63. The participants of a course 

Now, the user assigned the role “Teacher” has the ability to enroll students in the course (already 
added users to Moodle platform by the administrator) by assigning them the role “Student”. 
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Figure 64. Enrolling a student in the course 
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Appendix 2: Instructions to Moodle Administrators 

Steps to insert the Accessibility warning 

 

Figure 65. Example of the accessibility warning message. 

First of all, anyone wishing to make changes to the Moodle platform should have rights to access 
and modify the platform installation files on the server. The file that should be modified so as the 
Accessibility message to be constructed is “filemanager_page_generallayout.mustache” and it can 
be found following the path bellow: 
Path: /var/www/html/moodle/lib/templates/filemanager_page_generallayout.mustache 

 

Figure 66. The path where is the “filemanager_page_generallayout.mustache” file to be modified 

The code that should me inserted in the abovementioned file, so as the Accessibility message to be 
presented is the following (moodle, 2021ag): 
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Figure 67. Example of the code for creating the accessibility warning 

The initial file size that a user can upload on the platform is 2MB. To make it easier for users to 
organize lessons with large files, the maximum file size for files to be uploaded should have been 
modified into 20MB. For anyone wishing to make the modification mentioned before, he/she must 
have rights to enter and modify the “php.ini” file. This file can be found following the path bellow: 
Path: /etc/php/7.2/apache2/php.ini 

 

Figure 68. The path where is the "php.ini" file to be modified 

The code that should be inserted in the abovementioned file, so as the maximum file size to be 
modified is the following (moodle, 2021l): 

• post_max_size = 8M  post_max_size = 20M 

 
Figure 69. The example of the code for changing the “post_max_size” 
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• upload_max_filesize = 2M  upload_max_filesize = 20M 

 
Figure 70. The example of the code for changing the “upload_max_filesize” 
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• max_execution_time = 30  max_execution_time = 600 

 
Figure 71. The example of the code for changing the “max_execution_time” 

The following modification should be made to make it easier for users to find guidelines for creating 
accessible files from anywhere on the Moodle platform: 

 

Figure 72. Access to the main webpage from the custom menu item 

The code that should be inserted here is the following “Instructions for Creating Accessible 
Files|/course/view.php?id=5” (Hubken group, 2021). 
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Figure 73. The code so as to be feasible access to the main webpage from the custom menu item 

 
Figure 74. The custom menu item 

For anyone wishing to make the modification mentioned before, he/she must have an admin role on 
Moodle platform. 
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Appendix 3: Export and import a course from/to Moodle 

A useful feature that facilitates Moodle platform’s users is the export of information contained in 
selected (by the user who tries to export a course) courses already built on the Moodle platform. 
This function can also be used in the case of the “Instructions for creating accessible files” (see 
Appendix 3-10) in order to transfer them to a different installation of the platform. The InSIDE UOA 
project team has attempted to extract a course from the platform and the specific process is 
described below: right click on course settings  Backup  Next  Next  Perform backup  
Continue. 

 

Figure 75. Backup: Step 1 
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Figure 76. Backup: Step 2a 

 
Figure 77. Backup: Step 2b

 

Figure 78. Backup: Step 3 
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Figure 79. Backup: Step 4a 
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Figure 80. Backup: Step 4b

 

Figure 81. Backup: Step 4c

 

Figure 82. Backup: Step 5 

A user who wishes to import a course on Moodle platform, he/she should follow the steps below: 
right click on course settings  Restore  drag and drop the backup file he/she wishes into the drag 
and drop field  Restore. 
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Figure 83. Restore: Step 1 

 

Figure 84. Restore: Step 2 
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Appendix 4: Quick guidelines for creating accessible math 
documents with MS-Office 2010 

 
 

Quick guidelines for creating accessible math 
documents with MS-Office 2010 

Mathematics in accessible format using MS-Word 2010 

To insert Mathematics in an accessible format you must use the Equation Editor. 

Write/edit an equation 
Write an equation 

To write an equation follow the steps below: 

1. On Insert tab, in Symbols group, click the arrow next to Equation. 
2. Click the equation you want or click Insert New Equation and enter the equation you want 

in the equation box that opens. 
3. 3. Clicking on the equation box opens the Equation Tools tab. In this tab you can find 

symbols and structures that you can insert into your equation in the Symbols and 
Structures groups, respectively. 

4. When you have finished writing your equation, click outside the equation box. 

Integration or not of the equation 
To embed an equation in the text or to place it on a separate line follow the steps below: 

1. If you want to have your equation embedded in the sentence and in the text environment, 
click on the specific text where you want to enter the equation and follow steps 1 to 4. 

2. If you want to have your equation in a separate line centered between the margins of the 
page, follow steps 1 to 4, and then click the arrow to the right of the equation box to open 
the equation options. Select Change to Display. 

3. If you want to embed an equation that is in a separate line in the text, click the arrow to the 
right of the equation box to open the equation options. Select Change to Inline. You can 
select and drag the equation to a selected position within the text, so it will automatically be 
converted into built-in format. 

Edit an equation 
To edit an equation, follow the steps below: 

1. Click the equation you want to edit. 
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2. Make the changes you want. 
3. When you finished with the changes, click outside the equation box. 

Add an equation to the list of frequently used equations 
To add an equation to your list of frequently used equations, follow these steps: 

1. Select the equation you want to add to the list of frequently used equations by clicking on 
the dots on the left, something that will darken the content of the box. 

2. On the Equation Tools, on the Design tab, in the Tools group, click Equation. Then click 
Save Selection to Equation Gallery. 

3. In the Create New Building Block dialog box, type a name for the equation in the Name 
field. 

4. In the Gallery field, click Equations. 
5. Activate any other options you want. And click OK. 
6. The equation will be displayed along with the built-in equations. 

Mathematical symbols-Mathematical structures-Word Structures 

Mathematical symbols 
Not all Equation Editor symbols are converted into LaTeX. Here are the symbols that can be 
transformed using the Equation Editor. 

Standard 

𝑎𝑎, 𝑏𝑏, 𝑐𝑐,𝑑𝑑, 𝑒𝑒, 𝑓𝑓,𝑔𝑔,ℎ, 𝑖𝑖, 𝑗𝑗, 𝑘𝑘, 𝑙𝑙,𝑚𝑚, 

𝑛𝑛, 𝑜𝑜,𝑝𝑝, 𝑞𝑞, 𝑟𝑟, 𝑠𝑠, 𝑡𝑡,𝑢𝑢, 𝑣𝑣,𝑤𝑤, 𝑥𝑥,𝑦𝑦, 𝑧𝑧 

𝐴𝐴,𝐵𝐵,𝐶𝐶,𝐷𝐷,𝐸𝐸,𝐹𝐹,𝐺𝐺,𝐻𝐻, 𝐼𝐼, 𝐽𝐽,𝐾𝐾, 𝐿𝐿,𝑀𝑀, 

𝑁𝑁,𝑂𝑂,𝑃𝑃,𝑄𝑄,𝑅𝑅, 𝑆𝑆,𝑇𝑇,𝑈𝑈,𝑉𝑉,𝑊𝑊,𝑋𝑋,𝑌𝑌,𝑍𝑍 

Greek 

𝛼𝛼,𝛽𝛽, 𝛾𝛾, 𝛿𝛿, 𝜀𝜀, 𝜖𝜖, 𝜁𝜁, 𝜂𝜂,𝜃𝜃,𝜗𝜗, 𝜄𝜄, 𝜅𝜅, 𝜆𝜆, 𝜇𝜇, 𝜈𝜈, 𝜉𝜉, 

𝜊𝜊,𝜋𝜋,𝜛𝜛,𝜌𝜌, 𝜚𝜚,𝜎𝜎, 𝜍𝜍, 𝜏𝜏, 𝜐𝜐,𝜑𝜑,𝜙𝜙,𝜒𝜒,𝜓𝜓,𝜔𝜔 

The capital Greek letters should be converted into italics in order to be well transformed.  

𝛢𝛢,𝛣𝛣,𝛤𝛤,𝛥𝛥,𝛦𝛦,𝛧𝛧,𝛨𝛨,𝛩𝛩, 𝛪𝛪,𝛫𝛫,𝛬𝛬,𝛭𝛭, 

𝛮𝛮,𝛯𝛯,𝛰𝛰,𝛱𝛱,𝛲𝛲,𝛴𝛴,𝛵𝛵,𝛶𝛶,𝛷𝛷,𝛸𝛸,𝛹𝛹,𝛺𝛺 

Symbols in letters form 
∀, ∁,ℂ,𝜕𝜕, ð,Ϝ, Ⅎ,ℋ,ℌ,ℎ,ℏ, 𝚤𝚤,ℑ, 𝑗𝑗,𝜘𝜘,ℒ, ℓ,ℕ,℘, 

ℚ,ℛ,ℜ,ℝ,ℤ,℧,ℬ, ℰ,∃,∄,ℱ,ℳ,ℵ, ℶ, ℷ, ℸ 

Operators 
±,÷,×,∓,∝,𝑎𝑎 𝑏𝑏⁄ ,∗,∘,⋅,∩,∪,⊎,⊓,⊔,∧,∨ 

=,≠, <, >,≤,≥,≮,≰,≯,≱,≡,∼,≃,≈,≅,≇,∝,≪,≫, 

∈,∋,∉,⊂,⊃,⊆,⊇,≺,≻,≼,≽,⊏,⊐,⊑,⊒, ∥,⊥,⊢,⊣,≍ 
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∑∫∬∮∏∐ 

�𝑥𝑥 ,�𝑥𝑥 ,�𝑥𝑥,�𝑥𝑥, 

�𝑥𝑥,�𝑥𝑥, 

∔,∖,⋒,⋓,⊟,⊠,⊡,⊞,⋇,⋉,⋊,⋋,⋌,⋏,⋎,⊺,⊕,⊖,⊗,
𝑎𝑎
𝑏𝑏

,⊙,⊛,⊚, †, ‡,⋆,⋄,≀,△, 

∴,∵,⋘,⋙,≦,≧,≲,≳,⋖,⋗,≶,⋚,≷,⋛, 

≑,≒,≓,∽,≊,≼,≽,⋞,⋟,≾,≿,⋜,⋝ 

⊆,⊇,⊲,⊳,⊴,⊵,⊨,⋐,⋑,⊏,⊐,⊩,⊪,≖,≗,≜,≏,≎,∝,⋔,≐ 

Arrows 

←,→, ↑, ↓,↔, ↕,⇐,⇒,⇑,⇓,⇔,⇕,↗,↖,↘,↙, 

↚,↛,↮,⇍,⇏,⇎,↦,↼,↽,⇀,⇁, ↿, ↾, ⇃, ⇂, 

⇋,⇌,⇇,⇉,⇈,⇊,⇆,⇄,↫,↬,↢,↣,↰,↱, 

⇚,⇛,↞,↠,↶,↷,↺,↻,⊸,↭,⇝ 

Undo relational operators 

≠,≮,≯,≰,≱,≁,≇,≨,≩,⊀,⊁,⋠,⋡,∉, 

⊄,⊈,⊉,⊊,⊋,⋦,⋧,⋨,⋩,⋪,⋫,⋬,⋭, ∤, ∦,⊬,⊭,⊮,⊯,∄ 

Scripts 
MathPlayer does not read all letters from the script alphabet as script-letters. 

𝒜𝒜,ℬ,𝒞𝒞,𝒟𝒟, ℰ,ℱ,𝒢𝒢,ℋ, ℐ,𝒦𝒦,ℒ,ℳ, 

𝒩𝒩,𝒪𝒪,𝒬𝒬,ℛ,𝒮𝒮,𝒯𝒯,𝒰𝒰,𝒱𝒱,𝒲𝒲,𝒳𝒳,𝒴𝒴,𝒵𝒵 

MathType cannot properly convert P script into MathML for unknown reasons. 

Frakturs 
MathPlayer does not read all letters of Fraktur alphabet as Fracture-letters. 

𝔄𝔄,𝔅𝔅,ℭ,𝔇𝔇,𝔈𝔈,𝔉𝔉,𝔊𝔊,ℌ,ℑ,𝔍𝔍,𝔎𝔎,𝔏𝔏,𝔐𝔐, 

𝔑𝔑,𝔒𝔒,𝔓𝔓,𝔔𝔔,ℜ,𝔖𝔖,𝔗𝔗,𝔘𝔘,𝔙𝔙,𝔚𝔚,𝔛𝔛,𝔜𝔜,ℨ 

𝔞𝔞, 𝔟𝔟, 𝔠𝔠, 𝔡𝔡, 𝔢𝔢, 𝔣𝔣, 𝔤𝔤, 𝔥𝔥, 𝔦𝔦, 𝔧𝔧, 𝔨𝔨, 𝔩𝔩,𝔪𝔪, 

𝔫𝔫, 𝔬𝔬, 𝔭𝔭, 𝔮𝔮, 𝔯𝔯, 𝔰𝔰, 𝔱𝔱, 𝔲𝔲, 𝔳𝔳,𝔴𝔴, 𝔵𝔵, 𝔶𝔶, 𝔷𝔷 

Double struck 
MathPlayer does not read all letters of double struck alphabet as double struck - letters. 

𝔸𝔸,𝔹𝔹,ℂ,𝔻𝔻,𝔼𝔼,𝔽𝔽,𝔾𝔾,ℍ, 𝕀𝕀, 𝕁𝕁,𝕂𝕂,𝕃𝕃,𝕄𝕄, 

ℕ,𝕆𝕆,ℙ,ℚ,ℝ,𝕊𝕊,𝕋𝕋,𝕌𝕌,𝕍𝕍,𝕎𝕎,𝕏𝕏,𝕐𝕐,ℤ 
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Geometry 

∟,∠,∡,∢,⊥, ∤, ∥,∦, ∶,∴,∵ 

Mathematical structures 
It is not possible all the structures provided by the Word equation editor to be transformed. The 
equations can be placed either in an “inline” form in the text or as “displayed”. 

Inline math 

𝐴𝐴𝑖𝑖,𝑗𝑗,𝑘𝑘
2𝑛𝑛  

Displayed math 

�𝑥𝑥𝑖𝑖2 = 𝑥𝑥12 + 𝑥𝑥22 + 𝑥𝑥32  + 𝑥𝑥42  + 𝑥𝑥52  +  𝑥𝑥62  +  𝑥𝑥72  +  𝑥𝑥82  + 𝑥𝑥92  +  𝑥𝑥102
13

𝑖𝑖=1

+ 𝑥𝑥112 + 𝑥𝑥122 + 𝑥𝑥132  

𝑥𝑥12 = 𝑥𝑥22 = 𝑥𝑥32 = 𝑥𝑥32 = 𝑥𝑥42 = 𝑥𝑥52 = 𝑥𝑥62 = 𝑥𝑥72 = 𝑥𝑥82 = 𝑥𝑥92 = 𝑥𝑥102 = 𝑥𝑥112 = 𝑥𝑥122 = 𝑥𝑥132  

�𝑥𝑥𝑖𝑖2 = 𝑥𝑥12𝑥𝑥22𝑥𝑥32𝑥𝑥42𝑥𝑥52𝑥𝑥62𝑥𝑥72𝑥𝑥82𝑥𝑥92𝑥𝑥102 𝑥𝑥112 𝑥𝑥122 𝑥𝑥132
13

𝑖𝑖=1

 

�𝑥𝑥𝑖𝑖2 = 𝑥𝑥12 ⋅ 𝑥𝑥22 ⋅ 𝑥𝑥32 ⋅ 𝑥𝑥42 ⋅ 𝑥𝑥52 ⋅ 𝑥𝑥62 ⋅ 𝑥𝑥72 ⋅ 𝑥𝑥82 ⋅ 𝑥𝑥92 ⋅ 𝑥𝑥102 ⋅ 𝑥𝑥112 ⋅ 𝑥𝑥122 ⋅ 𝑥𝑥132
13

𝑖𝑖=1

 

��𝑥𝑥𝑖𝑖2
13

𝑖𝑖=1

= �𝑥𝑥12 + 𝑥𝑥22 + 𝑥𝑥32 + 𝑥𝑥42 + 𝑥𝑥52 + 𝑥𝑥62 + 𝑥𝑥72 + 𝑥𝑥82 + 𝑥𝑥92 + 𝑥𝑥102 + 𝑥𝑥112 + 𝑥𝑥122 + 𝑥𝑥132  

 

You can align the equations following the steps below: 

1) you create them as separately depicted objects ,  
2) you select them, 
3) right click, 
4) click on “Align at =”.  

𝑎𝑎 = 𝑏𝑏 + 𝑐𝑐 
= 𝑑𝑑 

However, this format will not be retained in other formats. Line changes will be lost and significant 
presentation problems may occur when translating into LaTeX. Keep the equations separate and 
do not choose to align them in the center as a group. 

�2𝑖𝑖 = 21 + 22 + 23 + 24 + 25 + 26 + 27 + 28 + 29 + 210 + 211 + 212 + 213
13

𝑖𝑖=1

 

= 2 + 4 + 8 + 16 + 32 + 64 + 128 + 256 + 1024 + 2048 + 4096 + 8192 

= 16382 in the equation tools, there is a button for entering normal text, too. 
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Word structures 
𝑎𝑎
𝑏𝑏

,𝑎𝑎 𝑏𝑏⁄ , 𝑎𝑎
𝑏𝑏
 

𝑥𝑥2,𝑥𝑥2,𝑥𝑥12, 𝑥𝑥12  

�𝑎𝑎, √𝑎𝑎𝑏𝑏 , √𝑎𝑎2 , √𝑎𝑎3  

�𝑥𝑥 ,� 𝑥𝑥
𝑏𝑏

𝑎𝑎
,�𝑥𝑥
𝑏𝑏

𝑎𝑎

,�𝑥𝑥 ,� 𝑥𝑥
𝑏𝑏

𝑎𝑎
,�𝑥𝑥

𝑏𝑏

𝑎𝑎

, 

�𝑥𝑥 ,� 𝑥𝑥
𝑏𝑏

𝑎𝑎
,�𝑥𝑥
𝑏𝑏

𝑎𝑎

, 

�𝑥𝑥 ,�𝑥𝑥
𝑏𝑏

𝑎𝑎

,� 𝑥𝑥
𝑏𝑏

𝑎𝑎
,�𝑥𝑥
𝑎𝑎

,� 𝑥𝑥
𝑎𝑎

 

�𝑥𝑥 ,�𝑥𝑥
𝑏𝑏

𝑎𝑎

,� 𝑥𝑥
𝑏𝑏

𝑎𝑎
,�𝑥𝑥
𝑎𝑎

,� 𝑥𝑥,
𝑎𝑎

�𝑥𝑥 ,�𝑥𝑥
𝑏𝑏

𝑎𝑎

,� 𝑥𝑥
𝑏𝑏

𝑎𝑎
,�𝑥𝑥
𝑎𝑎

,� 𝑥𝑥
𝑎𝑎

 

 

(𝑥𝑥), [𝑥𝑥], {𝑥𝑥}, |𝑥𝑥|, [𝑥𝑥[, ]𝑥𝑥], ]𝑥𝑥[, 

(𝑥𝑥, [𝑥𝑥, {𝑥𝑥, |𝑥𝑥, … , 𝑥𝑥|, 𝑥𝑥},𝑥𝑥], 𝑥𝑥) 

�𝑎𝑎𝑏𝑏 

�
𝑎𝑎
𝑏𝑏
𝑐𝑐
 

𝑎𝑎
𝑏𝑏

 

�
𝑎𝑎
𝑏𝑏
� 

sin𝑥𝑥 , cos𝑥𝑥 , tan𝑥𝑥 , csc𝑥𝑥 , sec𝑥𝑥 , cot𝑥𝑥 

sin−1 𝑥𝑥 , cos−1 𝑥𝑥 , tan−1 𝑥𝑥 , csc−1 𝑥𝑥 , sec−1 𝑥𝑥 , cot−1 𝑥𝑥 

sinh𝑥𝑥 , cosh𝑥𝑥 , tanh 𝑥𝑥 , csch𝑥𝑥 , sech𝑥𝑥 , coth𝑥𝑥, 

sinh−1 𝑥𝑥 , cosh−1 𝑥𝑥 , tanh−1 𝑥𝑥 , csch−1 𝑥𝑥 , sech−1 𝑥𝑥 , coth−1 𝑥𝑥 

log𝑎𝑎 𝑏𝑏 , log𝑏𝑏 , lim
𝑎𝑎
𝑏𝑏 , min

𝑎𝑎
𝑏𝑏 , max

𝑎𝑎
𝑏𝑏 , ln 𝑏𝑏 

∶=,==,+=,−=,≜,
𝑥𝑥
←,

𝑥𝑥
→,

𝑥𝑥
←,

𝑥𝑥
→,

𝑥𝑥
⇐,

𝑥𝑥
⇒,

𝑥𝑥
⇐,

𝑥𝑥
⇒,

𝑥𝑥
↔,

𝑥𝑥
↔,

𝑥𝑥
⇔,

𝑥𝑥
⇔ 

1 0
0 1 

1 0 0
0 1 0
0 0 1
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�
1 ⋯ 0
⋮ ⋱ ⋮
0 ⋯ 1

� 

�
1 ⋯ 0
⋮ ⋱ ⋮
0 ⋯ 1

� 

�1 0
0 1� , �1 0

0 1� , �1 0
0 1� 
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Mathematics in accessible format using MS-PowerPoint 2010 

To enter mathematics in an accessible format you should use the Equation Editor. 

Write/edit an equation 
Write an equation 

To write an equation follow the steps below: 

1. On the Insert tab, in the Symbols group, click the arrow below Equation. 
2. Click the equation you want or click Insert New Equation and type the equation you want 

in the colored area that appears on your slide. 
3. On the Equation Tools tab you can find symbols and structures that you can insert into 

your equation in Symbols and Structures groups, respectively. 
4. When you have finished writing your equation, click outside the colored area of the 

equation. 
5. To change your equation alignment, select it so as the colored area to be displayed and 

right-click on it. In the Display Math option, select the alignment you want. 

Edit an equation 
1. Click the equation you want to edit. 
2. Make the changes you want. 
3. When you finished with the changes, click outside the colored area of the equation. 
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InSIDE “Including Students with Impairments in Distance Education” is a project co-financed under the Erasmus+ 
Programme, Key Activity KA2: Cooperation for innovation and the exchange of good practices – Capacity Building 
in the field of Higher Education (Project No. 598763-EPP-1-2018-1-EL-EPPKA2-CBHE-JP) with three university 
partners from Europe and eleven university partners from Algeria, Morocco and Tunisia (Partner Countries). 

 
 
 
These guidelines have been produced by: 
 

 

 

National and Kapodistrian University of Athens 

Greece 
 
 

 

 
  

https://www.inside-project.org/
https://speech.di.uoa.gr/
https://speech.di.uoa.gr/
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Appendix 5: Quick guidelines for creating accessible 
documents with MS-Word 2010 

 
 

Quick guidelines for creating accessible documents 
with MS-Word 2010  

Use styles for the structure of large documents 

The structure of a document usually includes a title (and sometimes a subtitle), which are unique and can only 
be found on the first page. Also, a text is usually divided into multi-level chapters and sub-chapters where the 
appropriate heading corresponds. 
This rule ensures that the authors have used built-in styles throughout the whole text body, title, subtitle, 
headings, and paragraphs for documents containing at least 1200 words. Thus, a perceptual structure is 
created even for users with blindness who use a synthetic speech screen reader program. Headings should 
be short, i.e., a few words or a short phrase, so that users can easily and quickly navigate the document. Also, 
the structure of the document should start with Heading1 (first level), and when the level of detail increases, 
the heading level should also increase, i.e., Headings2 (second level), Headings3, etc., follow Heading1, in 
order for the document to have a logical structure. It should have been decided in advance how many heading 
levels will be used, and if/how they will be numbered. 
Why? By using styles you can create a coherent structure in your documents, and the use of headings makes 
the navigation of your document easier. The headings numbering makes it easier for the user to understand 
the level of the text where he/she is located. 
How to use/add: To apply a style to the entire document, follow the next steps: 

1.1. Select the whole text. 
1.2. On the Home tab, in the Styles group, select the style you want for the body text (e.g., 

Normal or No spacing). 
1.3. Select the title text. 
1.4. On the Home tab, in the Styles group, click on Title. 
1.5. Select the subtitle text. 
1.6. On the Home tab, in the Styles group, click on Subtitle. 
If you want to use the default heading numbering type, move to step 1.10 
1.7. If you want to set the numbering type for the headings, in the Home tab, in the Styles group, 

right-click on Heading1 and select Modify Style. 
1.8. In the Modify Style window, click Format and then Numbering and Bullets. Select the 

numbering type that you want and click OK. 
1.9. Repeat the above two steps for all the heading levels you are going to use. 
1.10. Select the heading text. 
1.11. On the Home tab, in the Style group, click the Heading that corresponds to the desired 

level. 
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Use alternative text in all objects 

This rule ensures that the authors have provided alternative text for the following objects: images, graphs, 
photographs, data tables, shapes. 
Why? Through alternative text, users, even people with blindness, perceive the information presented in 
images and other objects in alternative ways (such as audio or tactile). 
How to fix: To add alternative text to the object, follow these steps: 
2.1. Right-click on the object and select Format Picture. For tables, right-click and select Table 

Properties. 
2.2. Click Alt Text. 
2.3. Add a description of the item in the Description field. Do not write alternative text in the Title 

field. If the object is an image, the description should start with the word "image" or 
equivalent (e.g., logo, shape). 

2.4. When you have finished click on "Close". 
Note: The above rule is applied in exactly the same way to the following object categories: ClipArt images, 

SmartArt graphics, embedded objects, video and audio files, groups (all objects, except shapes, 
must have alternative text also when belonging to groups). 

Use tables with simple structure and a header line 

This rule ensures that authors have used tables with a simple, two-dimensional structure that do not contain 
merged or split cells and have correctly defined a header line (or lines) for the tables. If the table extends to 
more than one page, it is necessary to add a header line in it. 
Why? The table should have a simple two-dimensional structure and a header line, so that people with 
disabilities can easily navigate and understand it. Somebody who uses a screen reader program will have 
difficulty navigating the table in case he/she needs for example to combine the values from two cells to 
understand the content of the table. 
How to add: To add a table with a two-dimensional structure and a header line, follow these steps: 
3.1. On the Insert tab, click Table. 
3.2. In the Insert Table window, click Insert Table and create the table you want. You can also 

use some of the built-in MS-Word tables by clicking Quick Tables. 
3.3. Select the table and highlight the row (or rows) you want to define as a header. 
3.4. On the Table Tools tab, click Layout. 
3.5. In the Data group, click Repeat Header Rows. The header line is also, automatically added 

on the next page. 

Additional tips  

4.1 Choose fonts that are easy to read and can often be found in documents (e.g., Sans Serif), 
such as Arial, Verdana, Tahoma, Calibri.  

4.2 The font size should not be less than 10pt. Recommended document font sizes are between 
12pt and 18pt. 

4.3 Use automatic page numbering. Do not manually type page numbers at the bottom of the 
page. 

4.4 Do not use repetitive blank characters (spaces, TAB characters, paragraph characters). 
People who use screen reader programs may find repetitive blank characters as spaces 
annoying. 

4.5 Use the automatic lists (bullets), and numbering to define text lists. 
4.6 Use MS Word columns to structure your document into columns. Do not use the Tab button 

to create columns. Also, use enough margin to separate your columns facilitating user with 
low vision. 
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4.7 Do not use empty cells, rows, or columns in your tables. Empty cells can mislead people with 
blindness. 

4.8 Do not use tables to align text or other objects (e.g., images) within your document. Tables 
should only be used for data. 

4.9 Do not underline words, titles, headings, or text. 
4.10 The font and background color combination should be appropriate to maintain a high color 

contrast in the document. An example of high color contrast is black font on white 
background, while light gray / yellow / blue font on white background are low color contrast 
combinations. 

Scientific symbols, multimedia, etc. 

If your document contains scientific symbols (such as chemistry or mathematical formulas), see the relevant 
guidelines. 

Check of the accessibility level 

MS-Word 2010 includes an Accessibility Checker that examines your document for a range of potential issues 
that people with disabilities may face. Each problem can be classified into one of the following categories: 

• Error: As accessibility error is content that is very difficult or impossible to be perceived by people with 
disabilities. 

• Warning: As accessibility warning is content that in most, but not all cases, is very difficult to be 
perceived by people with disabilities. 

• Tips: As accessibility tip is content that can be perceived by people with disabilities, but it should be 
better organized or presented in order to maximize the information perceived. 

Whenever the Accessibility Checker detects a problem, the Accessibility Checker window displays information 
about why the content may not be accessible. By selecting the respective problem, instructions on how to fix 
or revise it are displayed. 

How to use the Accessibility Checker: 
6.1 Click the File tab. 
6.2 Click Info. 
6.3 In the Prepare for Sharing area, a notification will appear if the Accessibility Checker has 

detected any accessibility issues. 
6.4 If you want to view and fix the problems in your file, click Check for Issues, and then click 

Check Accessibility. 
6.5 Return to your file, where the Accessibility Checker window is open and displays the 

inspection results. 
6.6 Click on a specific issue to see Additional Information on how to fix or revise the content. 
 

 

Detailed guidelines for creating accessible documents with MS-Word 2010 for Windows 

Detailed guidelines for creating accessible documents with MS-Word 2011 for Mac 

 

  

http://insidemoodle.di.uoa.gr/pluginfile.php/167/mod_page/content/2/Quick%20guidelines%20for%20creating%20accessible%20math%20documents%20with%20MS-Office%202010.pdf
http://insidemoodle.di.uoa.gr/pluginfile.php/167/mod_page/content/2/Quick%20guidelines%20for%20creating%20accessible%20math%20documents%20with%20MS-Office%202010.pdf
https://webaim.org/techniques/word/word2010
https://webaim.org/techniques/word/word2011
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www.inside-project.org 

 
 
InSIDE “Including Students with Impairments in Distance Education” is a project co-financed under the Erasmus+ 
Programme, Key Activity KA2: Cooperation for innovation and the exchange of good practices – Capacity Building 
in the field of Higher Education (Project No. 598763-EPP-1-2018-1-EL-EPPKA2-CBHE-JP) with three university 
partners from Europe and eleven university partners from Algeria, Morocco and Tunisia (Partner Countries). 

 
 
 
These guidelines have been produced by: 
 

 

 
 
 
National and Kapodistrian University of Athens 
Greece 
 
 

 

 
  

https://www.inside-project.org/
https://speech.di.uoa.gr/
https://speech.di.uoa.gr/
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Appendix 6: Quick guidelines for creating accessible 
documents with MS-Word 2016 

 

 
 

Quick guidelines for creating accessible documents 
with MS-Word 2016  

Use styles for the structure of large documents 

The structure of a document usually includes a title (and sometimes a subtitle), which are unique and can only 
be found on the first page. Also, a text is usually divided into multi-level chapters and sub-chapters where the 
appropriate heading corresponds. 
This rule ensures that the authors have used built-in styles throughout the whole text body, title, subtitle, 
headings, and paragraphs for documents containing at least 1200 words. Thus, a perceptual structure is 
created even for users with blindness who use a synthetic speech screen reader program. Headings should 
be short, i.e., a few words or a short phrase, so that users can easily and quickly navigate the document. Also, 
the structure of the document should start with Heading1 (first level), and when the level of detail increases, 
the heading level should also increase, i.e., Headings2 (second level), Headings3, etc., follow Heading1, in 
order for the document to have a logical structure. It should have been decided in advance how many heading 
levels will be used, and if/how they will be numbered. 
Why? By using styles you can create a coherent structure in your documents, and the use of headings makes 
the navigation of your document easier. The headings numbering makes it easier for the user to understand 
the level of the text where he/she is located. 
How to use/add: To apply a style to the entire document, follow the next steps: 

1.1. Select the whole text. 
1.2. On the Home tab, in the Styles group, select the style you want for the body text (e.g., 

Normal or No spacing). 
1.3. Select the title text. 
1.4. On the Home tab, in the Styles group, click on Title. 
1.5. Select the subtitle text. 
1.6. On the Home tab, in the Styles group, click on Subtitle. 
If you want to use the default heading numbering type, move to step 1.10 
1.7. If you want to set the numbering type for the headings, in the Home tab, in the Styles group, 

right-click on Heading1 and select Modify Style. 
1.8. In the Modify Style window, click Format and then Numbering and Bullets. Select the 

numbering type that you want and click OK. 
1.9. Repeat the above two steps for all the heading levels you are going to use. 
1.10. Select the heading text. 
1.11. On the Home tab, in the Style group, click the Heading that corresponds to the desired 

level. 
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Use alternative text in all objects 

This rule ensures that the authors have provided alternative text for the following objects: images, graphs, 
photographs, data tables, shapes. 
Why? Through alternative text, users, even people with blindness, perceive the information presented in 
images and other objects in alternative ways (such as audio or tactile). 
How to fix: To add alternative text to the object, follow these steps: 
2.5. Right-click on the image/object and select Format Picture/Object. 
2.6. The Format Picture/Object window will appear on the right side of the screen. Click Alt 

Text. οn the Layout and Properties icon. 
2.7. Add a description of the item in the Description field. Do not write alternative text in the Title 

field. If the object is an image, the description should start with the word "image" or 
equivalent (e.g., logo, shape). 

2.8. For tables, right-click and select Table Properties. 
2.9. In the Table Properties window, click Alt Text. 
2.10. Add a description of the item in the Description field. Do not write alternative text in the Title 

field. 
Note: The above rule is applied in exactly the same way to the following object categories: SmartArt graphics, 

embedded objects, video and audio files, groups (all objects, except shapes, must have 
alternative text also when belonging to groups). 

Use tables with simple structure and a header line 

This rule ensures that authors have used tables with a simple, two-dimensional structure that do not contain 
merged or split cells and have correctly defined a header line (or lines) for the tables. If the table extends to 
more than one page, it is necessary to add a header line in it. 
Why? The table should have a simple two-dimensional structure and a header line, so that people with 
disabilities can easily navigate and understand it. Somebody who uses a screen reader program will have 
difficulty navigating the table in case he/she needs for example to combine the values from two cells to 
understand the content of the table. 
How to add: To add a table with a two-dimensional structure and a header line, follow these steps: 
3.6. On the Insert tab, click Table. 
3.7. In the Insert Table window, click Insert Table and create the table you want. You can also 

use some of the built-in MS-Word tables by clicking Quick Tables. 
3.8. Select the table and highlight the row (or rows) you want to define as a header. 
3.9. On the Table Tools tab, click Layout. 
3.10. In the Data group, click Repeat Header Rows. The header line is also, automatically added 

on the next page. 

Additional tips 

4.11 Choose fonts that are easy to read and can often be found in documents (e.g., Sans Serif), 
such as Arial, Verdana, Tahoma, Calibri.  

4.12 The font size should not be less than 10pt. Recommended document font sizes are between 
12pt and 18pt. 

4.13 Use automatic page numbering. Do not manually type page numbers at the bottom of the 
page. 

4.14 Do not use repetitive blank characters (spaces, TAB characters, paragraph characters). 
People who use screen reader programs may find repetitive blank characters as spaces 
annoying. 

4.15 Use the automatic lists (bullets), and numbering to define text lists. 
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4.16 Use MS Word columns to structure your document into columns. Do not use the Tab button 
to create columns. Also, use enough margin to separate your columns facilitating user with 
low vision. 

4.17 Do not use empty cells, rows, or columns in your tables. Empty cells can mislead people with 
blindness. 

4.18 Do not use tables to align text or other objects (e.g., images) within your document. Tables 
should only be used for data. 

4.19 Do not underline words, titles, headings, or text. 
4.20 The font and background color combination should be appropriate to maintain a high color 

contrast in the document. An example of high color contrast is: black font on white 
background, while light gray / yellow / blue font on white background are low color contrast 
combinations. 

Use scientific symbols, multimedia, etc. 

If your document contains scientific symbols (such as chemistry or mathematical formulas), see the relevant 
guidelines. 

Check of the accessibility level 

MS-Word 2016 includes an Accessibility Checker that examines your document for a range of potential issues 
that people with disabilities may face. Each problem can be classified into one of the following categories: 

• Error: As accessibility error is content that is very difficult or impossible to be perceived by people with 
disabilities. 

• Warning: As accessibility warning is content that in most, but not all cases, is very difficult to be 
perceived by people with disabilities. 

• Tips: As accessibility tip is content that can be perceived by people with disabilities, but it should be 
better organized or presented in order to maximize the information perceived. 

Whenever the Accessibility Checker detects a problem, the Accessibility Checker window displays 
information about why the content may not be accessible. By selecting the respective problem, instructions on 
how to fix or revise it are displayed. 

How to use the Accessibility Checker: 
6.7 Click the File tab. 
6.8 Click Info. 
6.9 If you want to view and fix the problems in your file, click Check for Issues, and then click 

Check Accessibility. 
6.10 Return to your file, where the Accessibility Checker window is open and displays the 

inspection results. 
6.11 Click on a specific issue to see Additional Information on how to fix or revise the content. 
 

 

Detailed guidelines for creating accessible documents with MS-Word 2016 for Windows 

Detailed guidelines for creating accessible documents with MS-Word 2016 for Mac 

  

http://insidemoodle.di.uoa.gr/pluginfile.php/167/mod_page/content/2/Quick%20guidelines%20for%20creating%20accessible%20math%20documents%20with%20MS-Office%202010.pdf
http://insidemoodle.di.uoa.gr/pluginfile.php/167/mod_page/content/2/Quick%20guidelines%20for%20creating%20accessible%20math%20documents%20with%20MS-Office%202010.pdf
https://webaim.org/techniques/word/word2016win
https://webaim.org/techniques/word/word2016win
https://webaim.org/techniques/word/word2016mac
https://webaim.org/techniques/word/word2016mac
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Appendix 7: Quick guidelines for creating accessible 
documents with LibreOffice4.0 Writer 

 
 

Quick guidelines for creating accessible documents 
with LibreOffice4.0 Writer  

Use styles for the structure of large documents 

The structure of a document usually includes a title (and sometimes a subtitle), which are unique and can only 
be found on the first page. Also, a text is usually divided into multi-level chapters and sub-chapters where the 
appropriate heading corresponds. 
This rule ensures that the authors have used built-in styles throughout the whole text body, title, subtitle, 
headings, and paragraphs for documents containing at least 1200 words. Thus, a perceptual structure is 
created even for users with blindness who use a synthetic speech screen reader program. Headings should 
be short, i.e., a few words or a short phrase, so that users can easily and quickly navigate the document. Also, 
the structure of the document should start with Heading1 (first level), and when the level of detail increases, 
the heading level should also increase, i.e., Headings2 (second level), Headings3, etc., follow Heading1, in 
order for the document to have a logical structure. It should have been decided in advance how many heading 
levels will be used, and if/how they will be numbered. 
Why? By using styles you can create a coherent structure in your documents, and the use of headings makes 
the navigation of your document easier. The headings numbering makes it easier for the user to understand 
the level of the text where he/she is located. 
How to use/add: To apply a style to the entire document, follow the next steps: 
• Select the whole text. 
Α.1.1. Click the Format menu and select Styles and Formatting or press F11 so as the Style 

and Formatting window in which you can select Text Body to be displayed. 
Α.1.2. Select the text to be modified into title. 
Α.1.3. In Style and Formatting window, click Title. 
Α.1.4. Select the text to be modified into subtitle. 
Α.1.5. In Style and Formatting window, click Subtitle. 
If you want to use the built-in headings, go to step 1.10. 
Α.1.6. If you want to set the numbering type for the headings, click Tools menu, select Outline 

Numbering, and in the Outline Numbering window that is displayed, select the Numbering 
tab. 

Α.1.7. Select the number "1" below the Level and in the Paragraph style option select Heading1. 
In the Number option, select the type of numbering you want. In Character style, select 
Numbering characters. Then, in the start from option, select the number from which you 
want the numbering to start. 

Α.1.8. Repeat the abovementioned step for all the headings levels that you will use, each time 
selecting the appropriate number below the Level, e.g.: for Heading2 the number "2" and so 
on. 

Α.1.9. Select the text to be modified into heading. 
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Α.1.10. Click the Format menu and select Styles and Formatting or press F11 so as the Style 
and Formatting window to be displayed and then, click the Header that corresponds to the 
desired level. 

Use alternative text in all objects 

This rule ensures that the authors have provided alternative text for the following objects: images, graphs, 
photographs, data tables, shapes. 
Why? Through alternative text, users, even people with blindness, perceive the information presented in 
images and other objects in alternative ways (such as audio or tactile). 
How to fix: To add alternative text to the object, follow these steps: 
2.1. Right-click on the item and select Description. 
2.2. Enter a brief description of the object in the Title field. If you want, you can enter a more 

detailed description in the Description field. If the object is an image, the description should 
start with the word "image" or equivalent (e.g.: logo, shape). 

2.3. When you have finished, click "OK". 

Use tables with simple structure and a header line 

This rule ensures that authors have used tables with a simple, two-dimensional structure that do not contain 
merged or split cells and have correctly defined a header line (or lines) for the tables. If the table extends to 
more than one page, it is necessary to add a header line in it. 
Why? The table should have a simple two-dimensional structure and a header line, so that people with 
disabilities can easily navigate and understand it. Somebody who uses a screen reader program will have 
difficulty navigating the table in case he/she needs for example to combine the values from two cells to 
understand the content of the table. 
How to fix: To add a table with a two-dimensional structure and a header line, follow these steps: 
3.1. Click the Table menu, select Insert, and then select Table. 

3.2. In the Insert Table window, select the number of columns and rows to create the table you 
want. You can also use some of the ready-made LibreOffice Writer tables by clicking Auto 
format. 

3.3. Right-click on the table and from the menu that opens click Table. 

3.4. In the Table format window, on the Text flow tab, click Repeat header and select how 
many rows will be repeated as a header. The header is automatically inserted on the next 
page. 

Additional tips 

• Choose fonts that are easy to read and can often be found in documents (e.g., Sans Serif), 
such as Arial, Verdana, Tahoma, Calibri. 

Α.2.1 The font size should not be less than 10pt. Recommended document font sizes are between 
12pt and 18pt. 

Α.2.2 Use automatic page numbering. Do not manually type page numbers at the bottom of the 
page. 

Α.2.3 Do not use repetitive blank characters (spaces, TAB characters, paragraph characters). 
People who use screen reader programs may find repetitive blank characters as spaces 
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annoying. If they hear a lot of " spaces", users may think they have reached the end of the 
document. 

Α.2.4 Use the automatic lists (bullets), and numbering to define text lists. 

Α.2.5 Use the built-in columns to structure your document into columns. Do not use the Tab button 
to create columns. Also, use enough margin to separate your columns facilitating user with 
low vision. 

Α.2.6 Do not use empty cells, rows, or columns in your tables. Empty cells can mislead people with 
blindness. 

Α.2.7 Do not create table-like structures using the Tab button or blank characters. 

Α.2.8 Do not use tables to align text or other objects (e.g., images) within your document. Tables 
should only be used for data. 

Α.2.9 Do not underline words, titles, headings, or text. 

Α.2.10 The font and background color combination should be appropriate to maintain a high color 
contrast in the document. An example of high color contrast is black font on white 
background, while light gray / yellow / blue font on white background are low color contrast 
combinations. 

Scientific symbols, multimedia, etc. 

If your document contains scientific symbols (such as chemistry or mathematical formulas), audio or video 
files, complex data tables, or a combination of texts in multiple languages, see the relevant guidelines. 

http://insidemoodle.di.uoa.gr/pluginfile.php/167/mod_page/content/2/Quick%20guidelines%20for%20creating%20accessible%20math%20documents%20with%20MS-Office%202010.pdf
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Appendix 8: Quick guidelines for creating accessible PDF 
files from accessible MS-Word & MS-PowerPoint 2010 

 
 

Quick guidelines for creating accessible PDF files 
from accessible MS-Word & MS-PowerPoint 2010 

Α. By using a special plug-in 

The «ZHAW PowerPoint and Word Accessibility» add-on used as a plug-in in MS Word 2010 και MS 
PowerPoint 2010 applications, checks your document for a range of potential problems that people with 
disabilities may face and creates corresponding accessible PDF files. Each issue is classified into one of the 
following categories: 

• Accessibility Issue: An accessibility issue is an issue that is very difficult or impossible to be 
perceived by people with disabilities. 

• Warning: An accessibility warning is an issue that can be very difficult for people with disabilities to 
perceive it. 

• Question: An accessibility question is an issue that may not be perceived by people with disabilities. 

Plug-in Installation Instructions  
1.12. Click on the link below: http://access.uoa.gr/ATHENA/gre/pages/download/837  
1.13. Download the «ZHAW PowerPoint and Word Accessibility» plug-in. 
1.14. Unzip the file to a folder of your choice. 
1.15. Make sure you have closed MS Word 2010 and MS PowerPoint 2010. 
1.16. Double-click the MSOfficeAccessibilityAddInsSetup.msi executable file. 
1.17. Follow the installation instructions on the screen. 
1.18. After the plug-in is successfully installed, restart Microsoft Word 2010. You will notice that 

a new tab called Accessibility has appeared. 
1.19. Clicking the Accessibility tab the available plug-in options are displayed. 
1.20. Click Settings and make sure all available options are selected on the Accessibility 

Checker tab. 
1.21. Click OK to close the window. 

Creation of accessible MS-Word or MS-PowerPoint file 
3.11. Follow the quick guidelines for creating accessible documents with MS-Word 2010 or the 

quick guidelines for creating accessible presentations with MS-PowerPoint 2010. 

Accessibility Check 
Α.2.1. Click the Accessibility tab. 
Α.2.2. Click Check Document. 

http://access.uoa.gr/ATHENA/gre/pages/download/837
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Α.2.3. Each time Accessibility Check detects an issue, the task window displays information about 
why the content may not be accessible. By selecting the specific issue, instructions are 
displayed on how to fix or revise it. 

Α.2.4. Click Apply to complete the correction of an error or warning. 

Document Conversion to PDF 
4.21 Click the Accessibility tab.  
4.22 Click Create Accessible PDF. 

If you want to lock your document with a password using Adobe Acrobat, make sure you have the option to 
enable text access for screen readers by following the instructions below: 
4.23 Click Tools and then, in the right column of the application, click the Protection menu. 
4.24 Click More Protection and then Security Properties. 
4.25 On the Security tab, click the Security Method menu and select Password Security. 
4.26 In the Permissions area, click Restrict editing and printing of the document. 
4.27 Make sure Enable text access for screen reader devices for the visually impaired is 

selected. 

 

B. Without using a special plug-in 

Creation of accessible MS-Word or MS-PowerPoint file 
Β.1.1 Α.1.1. Follow the quick guidelines for creating accessible documents with MS-Word 2010 

or the quick guidelines for creating accessible presentations with MS-PowerPoint 2010. 

Document Conversion to PDF 
First way: 

Β.2.1-a Click the File tab of MS-Word 2010 or MS-PowerPoint 2010. 
Β.2.2-a Click Save As. 
Β.2.3-a From the Save As menu, select PDF (*. Pdf). 

Second way: 
If you want to convert the document into PDF using Adobe Acrobat (provided that it is installed on your 
computer): 
Β.2.1-b Click the File tab.  
Β.2.2-b Click Save as Adobe PDF. 
Β.2.3-b If the application ask you to convert the document using Adobe PDF Maker, click OK 

If you want to lock your document with a password using Adobe Acrobat, make sure you have the option to 
enable text access for screen readers by following the instructions below: 
 
Β.2.4-b Click Tools and then, in the right column of the application, click the Protection menu. 
Β.2.5-b Click More Protection and then Security Properties. 
Β.2.6-b On the Security tab, click the Security Method menu and select Password Security. 
Β.2.7-b In the Permissions area, click Restrict editing and printing of the document. 
Β.2.8-b Make sure Enable text access for screen reader devices for the visually impaired is 

selected. 
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Accessibility Check 
In case you want to check the accessibility of your PDF document, follow the steps below: 

B.3.1. Click on the link below: http://access.uoa.gr/ATHENA/gre/pages/download/261  
B.3.2. Download the "PAC-PDF Accessibility Checker". 
B.3.3. Unzip the file to a folder of your choice. 
B.3.4. Double-click the PAC.exe executable file. 
Note: It is necessary the PAC.exe and paclib.dll files to be in the same folder.  

B.3.5. In the window that appears, click Browse. 
B.3.6. Select the PDF document which you want to check for its accessibility, and then click 

Open. 
B.3.7. Click Start Check. 
B.3.8. When the accessibility check is complete, click Report, where a complete detailed report 

on the accessibility of the PDF document is provided. 
B.3.9. The included links facilitate you to navigate through the detailed report. Clicking on the 

error messages your document will be displayed and the most likely location of the error. 
 

Note: Steps B.3.1-B.3.3 to install the "PAC-PDF Accessibility Checker" are performed only once.  

 

Detailed guidelines for creating accessible PDF files with Adobe Acrobat  

Detailed guidelines for creating accessible PDF files with Foxit PhantomPDF   

http://access.uoa.gr/ATHENA/gre/pages/download/261
https://webaim.org/techniques/acrobat/
https://webaim.org/techniques/acrobat/
https://webaim.org/techniques/foxit/
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Appendix 9: Quick guidelines for creating accessible PDF 
documents from LibreOffice4.0 Writer & Impress 
accessible documents 

 
 

Quick guidelines for creating accessible PDF 
documents from LibreOffice4.0 Writer & Impress 

accessible documents 

To create accessible PDF documents using LibreOffice4.0 Writer/Impress applications follow the steps 
below: 

Creation of accessible LibreOffice Writer/Impress file 

Α.1.1. Follow the quick guidelines for creating accessible documents with LibreOffice4.0 
Writer/Impress. 

Document Conversion to PDF 

Α.2.1 Click the File tab 

Α.2.2 Click Export as PDF. 

Α.2.3 In the dialog box that appears, make sure that the PDF tagged and Bookmark export 
options are selected. 

Α.2.4 Click Export. 

Α.2.5 Select the desired location to save the file and click Save. 

If you want to lock your document with a password using Adobe Acrobat, make sure you have the option to 
enable text access for screen readers by following the instructions below: 
Α.2.6 Click Tools and then, in the right column of the application, click the Protection menu. 

Α.2.7  Click More Protection and then Security Properties. 

Α.2.8  On the Security tab, click the Security Method menu and select Password Security. 

Α.2.9  In the Permissions area, click Restrict editing and printing of the document. 

Α.2.10 Make sure Enable text access for screen reader devices for the visually impaired is 
selected. 



InSIDE project Page 
105 

WP3: Development 

2018-3218 /001-001 Deliverable DEV3.3 Adaptations and Delivery of LMS platform  

 

Accessibility Check 

In case you want to check the accessibility of your PDF document, follow the steps below: 

Β.1.1 Click on the link below: http://access.uoa.gr/ATHENA/gre/pages/download/261 
Β.1.2 Download the "PAC-PDF Accessibility Checker". 
Β.1.3 Unzip the file to a folder of your choice. 
Β.1.4 Double-click the PAC.exe executable file. 

Note: It is necessary the PAC.exe and paclib.dll files to be in the same folder. 
Β.1.5 In the window that appears, click Browse. 
Β.1.6 Select the PDF document which you want to check for its accessibility, and then click 

Open. 
Β.1.7 Click Start Check. 
Β.1.8 When the accessibility check is complete, click Report, where a complete detailed report 

on the accessibility of the PDF document is provided. 
Β.1.9 The included links facilitate you to navigate through the detailed report. Clicking on the 

error messages your document will be displayed and the most likely location of the error. 
Note: Steps B.3.1-B.3.3 to install the "PAC-PDF Accessibility Checker" are performed only 
once. 

 

Detailed guidelines for creating accessible PDF files with Adobe Acrobat  

Detailed guidelines for creating accessible PDF files with Foxit PhantomPDF  

http://access.uoa.gr/ATHENA/gre/pages/download/261
http://access.uoa.gr/ATHENA/gre/pages/download/261
http://access.uoa.gr/ATHENA/gre/pages/download/261
http://access.uoa.gr/ATHENA/gre/pages/download/261
http://access.uoa.gr/ATHENA/gre/pages/download/261
http://access.uoa.gr/ATHENA/gre/pages/download/261
http://access.uoa.gr/ATHENA/gre/pages/download/261
http://access.uoa.gr/ATHENA/gre/pages/download/261
http://access.uoa.gr/ATHENA/gre/pages/download/261
http://access.uoa.gr/ATHENA/gre/pages/download/261
http://access.uoa.gr/ATHENA/gre/pages/download/261
http://access.uoa.gr/ATHENA/gre/pages/download/261
http://access.uoa.gr/ATHENA/gre/pages/download/261
http://access.uoa.gr/ATHENA/gre/pages/download/261
http://access.uoa.gr/ATHENA/gre/pages/download/261
http://access.uoa.gr/ATHENA/gre/pages/download/261
http://access.uoa.gr/ATHENA/gre/pages/download/261
https://webaim.org/techniques/acrobat/
https://webaim.org/techniques/foxit/
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Appendix 10: Quick guidelines for creating accessible 
presentations with MS-PowerPoint 2010 

 
 

Quick guidelines for creating accessible presentations 
with MS-PowerPoint 2010  

Alternative text to all objects 

This rule ensures that the authors have provided alternative text for the following objects: images, 
ClipArt images, graphs, photos, data tables, shapes (that do not contain text and do not belong to 
groups), SmartArt graphics, embedded objects, video and audio files, groups (all items in this list, 
except shapes, should also contain alternate text when they belong to groups). 
Why? With alternative text, users, even those with vision loss, perceive the information presented 
in images and other objects in alternative ways (such as through an audio or tactile way). 
How to fix: To add alternative text to the object, follow the steps below: 
1.1. Right-click on the object and select Format Picture. 
1.2. Click Alt Text. 
1.3. Enter a description of the item in the Description text field. Do not enter alternative text in 

the Title field. If the object is an image, the description should start with the word "image" or 
equivalent (e.g.: logo, shape). 

1.4. When you have finished, click "Close". 

Unique titles to all slides  

This rule ensures that the authors have correctly included a title for each presentation slide. 
Why? Slide titles are used for navigation and selection by those who cannot see the slide. 
How to fix: To add visible titles to the slides, follow the steps below: 
2.1. Click the Reset button on the Home tab to reset the placeholder symbols for the selected 

slide. 
2.2. Enter a unique name in the Title text box. 
If you do not want the title you created above to be visible on the slide, follow the steps below: 
2.3. Click the Arrange menu, located in the Drawing group, on the Home tab. 
2.4. Click the Selection Pane. 
2.5. Click the eye icon next to the text box of the slide title to make it appear or disappear. 

Logical reading order to all slides 

This rule ensures that whenever authors use objects that do not belong to the slide prototype, the 
reading order of the slide context makes sense. This is a very important rule, which highlights all 
slides containing similar objects. 
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Why? Those who do not see the slide will be able to hear the text of the slide, the shapes and their 
content be described in a specific order. Do not forget to check that the reading order and the 
labels make sense. 
How to fix: To check the order in which the content will be read, follow the steps below: 
3.1. On the Home tab, in the Drawing group, click Arrange and select the Selection Pane. 
3.2. The slide objects appear in the Selection window. The objects reading starts from the last 

item in the list and ends at the first item in the list. With the Re-order arrows at the bottom of 
the window you can modify any item that is not in the right order. 

Increase/Improve visibility for users with color blindness 

This rule ensures that users with color blindness, who cannot distinguish colors, can perceive what 
they see if elements that increase visual contrast are used. 
Why? Users with color blindness cannot perceive the difference in a text that is used red and 
green colour. 
How to fix:  
4.1 Avoid using red, green, and orange colour on slides and text. 
4.2 Use different textures in graphics, instead of different colors, where you want to emphasize 

something. 
4.3 Circle the information you want to highlight, instead of using color or laser pointer during the 

presentation. 
4.4 Maintain high color contrast in the whole presentation. 
 

Use of scientific symbols, multimedia, multiple languages 

If your slides contain scientific symbols (such as chemistry or mathematical formulas), audio or 
video files, composite datasets, or text combinations in multiple languages, see the relevant 
guidelines. 

Accessibility check 

The 2010 version of MS-Office includes the Accessibility Checker tool that examines your slides for 
a range of potential issues that users with disabilities may face. Each issue is classified into one of 
the following categories: 

• Errors: As accessibility error is defined a content that is very difficult or impossible to be 
perceived by people with disabilities. 

• Warning: As accessibility warning is defined a content that in most, but not all cases, is 
very difficult to be perceived by people with disabilities. 

• Tips: As accessibility tip is defined a content that can be perceived by people with 
disabilities, but it should be better organized or presented in order to maximize the 
information perceived. 

Whenever the Accessibility Checker detects a problem, the Accessibility Checker window displays 
information about why the content may not be accessible. By selecting the respective problem, 
instructions on how to fix or revise it are displayed. 
How to use the Accessibility Checker: 
6.1 Click the File tab. 
6.2 Click Info. 
6.3 In the Prepare for Sharing area, a notification will appear if the Accessibility Checker has 

detected any accessibility issues. 
6.4 If you want to view and fix the problems in your file, click Check for Issues, and then click 

Check Accessibility. 

http://insidemoodle.di.uoa.gr/pluginfile.php/167/mod_page/content/2/Quick%20guidelines%20for%20creating%20accessible%20math%20documents%20with%20MS-Office%202010.pdf
http://insidemoodle.di.uoa.gr/pluginfile.php/167/mod_page/content/2/Quick%20guidelines%20for%20creating%20accessible%20math%20documents%20with%20MS-Office%202010.pdf
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6.5 Return to your file, where the Accessibility Checker window is open and displays the 
inspection results. 

6.6 Click on a specific issue to see Additional Information on how to fix or revise the content.  
 

Detailed guidelines for creating accessible presentations with MS-PowerPoint 2010 

  

https://webaim.org/techniques/powerpoint/
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Appendix 11: Quick guidelines for creating accessible 
presentations with LibreOffice4.0 Impress 

 
 

Quick guidelines for creating accessible presentations 
with LibreOffice4.0 Impress  

Alternative text to all objects 

This rule ensures that the authors have provided alternative text for the following objects: images, 
ClipArt images, graphs, photos, data tables, shapes (that do not contain text and do not belong to 
groups), SmartArt graphics, embedded objects, video and audio files, groups (all items in this list, 
except shapes, should also contain alternate text when they belong to groups). 
Why? With alternative text, users, even those with vision loss, perceive the information presented 
in images and other objects in alternative ways (such as through an audio or tactile way). 
How to fix: To add alternative text to the object, follow the steps below: 
• Right-click on the object and select Description. 
2.4. Enter a description of the item in the Title text field. If you want, you can enter a more 

detailed description in the Description field. If the object is an image, the description must 
start with the word "image" or equivalent (e.g.: logo, shape). 

2.5. When you have finished click on "OK". 

Unique titles to all slides 

This rule ensures that the authors have correctly included a title for each presentation slide. 
Why? Slide titles are used for navigation and selection by those who cannot see the slide. 
How to fix: Use embedded slide layouts that already contain a Title text box. Enter a unique title in 
the text box that corresponds to the Title. 

Logical reading order to all slides 

This rule ensures that whenever authors use objects that do not belong to the slide prototype, the 
reading order of the slide context makes sense. This is a very important rule, which highlights all 
slides containing similar objects. 
Why? Those who do not see the slide will be able to hear the text of the slide, the shapes and their 
content be described in a specific order. Do not forget to check that the reading order and the 
labels make sense. 
How to fix: Use embedded slide layouts because they are more accessible to those who use 
assistive technology. For example, the order of reading on a Slide with Title and Objects is the Title 
to be read first and then the other objects, moving from left to right and from top to bottom. 
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Increase/Improve visibility for users with color blindness 

This rule ensures that users with color blindness, who cannot distinguish colors, can perceive what 
they see if elements that increase visual/colour contrast are used. 
Why? Users with color blindness cannot perceive the difference in a text that is used red and 
green colour. 
How: 
4.1 Avoid using red, green, and orange colour on slides and text. 
4.2 Use different textures in graphics, instead of different colors, where you want to emphasize 

something. 
4.3 Circle the information you want to highlight, instead of using color or laser pointer during the 

presentation. 
4.4 Maintain high color contrast in the whole presentation. 

Use of scientific symbols, multimedia, multiple languages 

If your slides contain scientific symbols (such as chemistry or mathematical formulas), audio or 
video files, composite datasets, or text combinations in multiple languages, see the relevant 
guidelines. 

http://insidemoodle.di.uoa.gr/pluginfile.php/167/mod_page/content/2/Quick%20guidelines%20for%20creating%20accessible%20math%20documents%20with%20MS-Office%202010.pdf
http://insidemoodle.di.uoa.gr/pluginfile.php/167/mod_page/content/2/Quick%20guidelines%20for%20creating%20accessible%20math%20documents%20with%20MS-Office%202010.pdf
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